
Using Mai
CHAPTER 1 Introduction 
to MainActor 5

What is MainActor? 5
 What do I need to use MainActor? 7
 Using the User’s Guide 8
 What This Guide Is Not 9
 Understanding the Terminology 9

CHAPTER 2 Installation 11

CHAPTER 3 Jump Start 19

It Doesn’t Get Any Easier 19
Inserting the Video Clip 20
Inserting a Transition 23
Exporting Your New Video 25

CHAPTER 4 MainActor
Video Editor 29

Starting MainActor Video Editor 30
The Lay of the Land 30
Getting Help 33

CHAPTER 5 MainActor VE
Projects 35

Converting Video Formats35
Creating an Animated GIF39
nActor 1



2

Extracting Frames from an 
Animation 46

CHAPTER 6 MainActor Sequencer 51

Starting MainActor Sequencer 52
 The Lay of the Land 52
Getting Help 55
Mouse-Keyboard Shortcuts 55

CHAPTER 7 MainActor Sequencer 
Projects 59

Creating a MainActor Sequencer 
Project 59
Overlaying Scrolling Text 68
Overlaying 3D Animated Text 77
Adding Effects to a Video Track 93

CHAPTER 8 MainActor
Video Capture 107

Introduction to MainActor Video 
Capture 107
The Video Capture Application 109
Video Capture Tutorial 111
Video Capture Tips 112

CHAPTER 9 MainActor
DV-Capture 117

What is Digital Video? 117
Using MainActor



Using Mai
What Do I Need to Use DV-
Capture? 118
Using MainActor DV-Capture 118
DV-Capture Tutorial 121

CHAPTER 10 MainActor
DV-Out 125

What Do I Need to Use DV-Out? 125
Using MainActor DV-Out 126
DV-Out Tutorial 129

APPENDIX A Supported File 
Formats 133

Loader Modules 134
Saver Formats 141

APPENDIX B MainActor VE
Command Reference 149

Introduction 149
Menu List Commands 149
The Save Window 167

APPENDIX C MainActor Sequencer
Command Reference 173

Menu Commands 173
nActor 3



4
 Using MainActor



CHAPTER 1 Introduction 
to MainActor
Welcome to MainActor, a Video Editing and Sequencing suite for Windows NT/
2000, Windows 98, Windows 95, and Linux. This User’s Guide will help you learn 
to use the various tools and features in this suite

What is MainActor?

MainActor is a set of computer programs that allow you to edit and sequence multi-
media videos. With MainActor, it is possible to perform many of the same tasks 
that professional video production studios do when they are preparing film for 
broadcast.

With MainActor, it is possible to:

•  Capture video from tape (with the proper computer hardware and interface 
cabling);

•  Create web animations;
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•  Splice various file formats (QuickTime movies, Windows AVIs, 
MPEGs) into one large file;

•  Edit and clean up home movies;

•  Create slide shows and presentations;

•  Play almost any video format available today;

•  And more.

The MainActor suite consists of five separate programs. Each of these 
programs performs different tasks, and together they allow you to do 
almost anything with recorded media.

 MainActor Video Editor (VE) allows you to work with animation’s 
on a frame-by-frame basis. Using MainActor VE, you can extract 
frames from videos to use as stills in other projects, assemble frames 
for a hand-drawn animated movie or a web animation, even convert 
animation’s from one file format to another.

MainActor Sequencer allows you to combine multiple animations in 
one project, as well as add text overlays, create special effects like 
fades and wipes, and add musical scores and other sound effects.

MainActor Video Capture is used to capture video using your analog 
video capture hardware equipment.

MainActor DV-Capture is used to capture the output of a Digital 
Video device.

MainActor DV-Out is used to send digital video data to a Digital 
Video recording device.
Using MainActor
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What do I need to use MainActor?
 What do I need to use MainActor?

To use MainActor, you need at least a Pentium level PC running Win-
dows 95, Windows 98, Windows NT/2000 or Linux. The more power-
ful your processor, the better MainActor will run on your machine.

Some computer chips have access to special instructions that aid in the 
rendering of certain kinds of multimedia formats. This instruction set, 
called MMX, can be exploited by MainActor: if you have an MMX 
Machine, certain functions and commands will take less time to per-
form.

Editing and rendering animations can be very system intensive. It’s 
safe to say that even if you’re able to run the program, actually doing 
anything with it on low-powered machines will be a very, very uncom-
fortable process. More powerful and faster processors (such as the Pen-
tium II/III or the AMD Athlon), machines with large amounts of RAM, 
and hard drives with high access speeds will be better able to handle 
the large volumes of data required when trying to use fancy video 
effects and transitions.

If you want to use MainActor to capture and store video on your com-
puter, you need a compatible video capture card for analog devices, a 
Firewire card for DV devices, and the proper cabling in order to trans-
fer the data correctly. If you received this program with an ELSA 
graphics card you should have the hardware you need. You do not need 
this equipment to use the rest of MainActor’s capabilities.

Finally, MainActor requires DirectX to function properly when run on 
a Microsoft Operating System. If you are using the original version of 
Windows 95, you will have to install DirectX. The latest version of 
DirectX can be downloaded from Microsoft’s Web site. If you are 
using the original version of Windows NT, Service Pack 3 or higher 
will give you the DirectX support needed to run MainActor.
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 Using the User’s Guide

There are seven chapters in this guide:

• Chapter 1: Introduction, which is the section you are reading now, 
will give you some background information about MainActor, and 
introduce you to some of the concepts you will need to know before 
you start.

• Chapter 2: Installation shows you how to install MainActor from 
the CD-ROM.

• Chapter 3: Jump Start shows you how to get started quickly with 
MainActor

• Chapter 4: MainActor Video Editor (VE) introduces you to the 
MainActor VE module, and explains the various components and 
areas of the MainActor VE main window.

• Chapter 5: MainActor VE Projects sets up some “real life” tasks
using MainActor VE.

• Chapter 6: MainActor Sequencer introduces you to the MainActor 
Sequencer module, and explains the various components and areas 
of the main window and some satellites. and shows you how to use 
many of its powerful sequencing features by taking you step by step 
through a series of projects. 

• Chapter 7: MainActor Sequencer Projects sets up a number of “
life” tasks using MainActor Sequencer.

• Chapter 8: MainActor Video Capture teaches you how to use the 
analog video capturing software that comes with MainActor (for 
the Windows platforms only).

• Chapter 9: MainActor DV-Capture covers the use of digital video 
(DV) devices to capture video

• Chapter 10: MainActor DV-Out explains how to send digital video 
from MainActor to a digital video (DV) device.
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 What This Guide Is Not

The User’s Guide is not intended to be a full-fledged user’s manual, 
with complete listings of every feature included in MainActor. Instead, 
it is intended to be a tutorial that will give you a basic understanding of 
all the components within the MainActor Suite. After reading this 
guide you will be able to use MainActor for many tasks, and you will 
be able to figure out how to use it for many more.

We encourage you to visit the MainConcept web site at 
www.mainconcept.com (USA) or www.mainconcept.de (Germany) 
for the latest version of the program as well as news and support 
concerning MainActor.

 Understanding the Terminology

MainActor, and therefore this User’s Guide, has a specific vocabulary 
that it uses when referring to certain things. To avoid confusion later on 
in this guide, the most technical terms are listed here:

• Animation. Any kind of moving picture that is stored and played 
on a computer. Animations range from roughly drawn stick figures, 
to cartoons (such as the cartoons seen on TV, or at the movies), to 
live TV shows, to full-blown movies.

• Audio. Any sound connected with an animation.

• Frame. Animation’s are not really moving pictures, they are actu-
ally a series of still pictures shown in rapid succession, giving the 
illusion of movement. Each of these still pictures, the smallest com-
plete unit of an animation, is called a frame.

• Module. One of the five MainActor components in the suite: either 
MainActor VE, MainActor Sequencer, MainActor Video Capture, 
MainActor DV-Capture, or MainActor DV-Out.
nActor 9
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• Project. Any animation that is open and is being actively worked 
on.
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CHAPTER 2 Installation
Before you can run MainActor, you first must install it on your machine. This sec-
tion will walk you through the installation process.

As mentioned previously, MainActor for the Microsoft operating systems requires 
DirectX in order to function properly. DirectX can be downloaded from Microsoft’s 
web site, and NT users will receive DirectX support in Service Packs 3 or higher.

1. From your Windows desktop, insert the MainActor CD-ROM into your CD-
ROM drive. If Autoplay is enabled (the default), then the installation program will 
start by itself. If the installation does not automatically start, you will have to start it 
yourself. With the CD inserted into your CD-ROM drive, double-click on the CD-
ROM object in your My Computer folder. Then double-click on the file named 
Setup. 

RESULT: The Welcome Panel appears.
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2. Close down any other Windows programs you may be running, then 
click Next. 

RESULT: The Software License Agreement Panel appears.
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 If you agree to the terms of the Software License Agreement, click 
Yes. If not, click No. If you click Yes, the User Information Panel 
appears.

NOTE: If you click No, you will not be able to install the program.
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3. On the user Information Panel, enter your name, your company 
name (if applicable) and the serial number that came with the CD.

NOTE: The Next button will be grayed out until you enter the correct 
serial number.

4. Click Next. 

RESULT: The Choose Destination Location Panel appears.
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 5. The Choose Destination Location Panel will install MainActor to 
the C:\Program Files\MainActor directory by default. If you’d like to 
install the program to a different directory or on a different hard drive, 
click Browse... A dialog box will appear that will allow you to specify 
the new location. When you are ready to start the installation program, 
click Next. 

RESULT: The Select Program Folder Panel appears.
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6. The install program will create a program folder for MainActor 
called “MainActor for Windows” by default. This will be located in the
Start Button programs list so that MainActor may be started conve-
niently. If you would like to name the program folder something els
type in the new name in the highlighted text field. Click Next. 

RESULT: The Select Components Panel appears.
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7. At the Select Components Panel, choose the language you want 
MainActor to use by default (either English or German). Click Next. 

RESULT: The install program starts.

 8. At the end of the install program, you will have the opportunity to 
launch a readme file that provides updates and last minute information 
about the product. You’ll also have the opportunity to launch the pro-
gram itself. Click Finish to complete the install program.
nActor 17
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Setup is now complete.
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Tnis chapter shows you just how easy it is to use MainActor to produce sophisti-
cated videos even if you have never done them before.

It Doesn’t Get Any Easier

If we told you that you could produce a professional-quality video in ten minutes 
the first time you ever used MainActor, you’d probably be a bit skeptical, right?
Well, get out your watch because we’re about to prove it! MainActor is so easy
use that even beginners can produce amazing videos in minutes.

To prove how easy to use MainActor is  for beginners. we’ll show you how to p
duce a video with the following steps:

• insert a captured video clip into the MainActor Sequencer timeline

• drop a video transition onto the timeline

• drop a video effect onto the timeline

• export the video as an AVI or MPEG file
19
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Inserting the Video Clip

The first step to creating your video is to insert a video clip into the 
MainActor Sequencer timeline. The video clip will serve as the skele-
ton onto which you will add the video transition and video effect.

Start MainActor Sequencer. You will see the main window come up 
with the Video Profile Window on top. 

Simply accept the default video profile by pressing the Ok button. 
Then you will see the MainActor Sequencer main window:
Using MainActor
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Inserting the Video Clip
In the toolbar, click the Insert Multimedia button (located on the sec-
ond row on the far left):

A file dialog will appear and you can select a video clip (and AVI or 
MPEG file for example) that you have captured or previously created.
nActor 21
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Select the file you want to import and press the “Open” button.Mov
the cursor to the V1 track. The cursor will change and have a smal
film icon in the lower right indicating that you are inserting a video 
clip. There will also be a gray rectangle in the track that indicates th
length of the video clip:

Move the cursor along the V1 track until the timer reading is 
00:00:00.01 which indicates that you are at the first frame of the vid
clip that you are creating.Click the left mouse button to place the vid
clip on the timeline.
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Inserting a Transition

Now we will add a transition to the beginning of the beginning of the 
video clip that looks like swinging doors opening to reveal the video 
clip we just inserted. In the Browser Window make sure that the Video 
Transitions button (leftmost on the toolbar) is selected and then select 
“3D” in the Types list:

The transition we will use is the one in the upper left corner that loo
like vertical doors swinging back and forth. Click on it and drag it to
the Fx track in the timeline. Release the mouse button and the curs
will change to indicate that you are positioning this transition. Move
the cursor so that the transition is at the beginning of the timeline a
click the left mouse button to place the transition. We’ll want the tra
sition to last for one second, so move the cursor to the left edge of 
transition so that the cursor changes to horizontal arrows indicating
that you can change the length of the transition. Click and drag the
edge of the transition until it extends to the 00:00:01.00 point on th
etimeline. The timeline should now look like this:
nActor 23



Jump Start

24

si-
Now let’s add a solid block of color that the swinging doors will tran
tion from. Click the Insert Color button on the main toolbar:

and the Color Plate Window will appear:
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We want to have a solid color for our transition, so click the “Use St
Color Only” radio button. (We’ll use the default red color but if you 
want to choose another color, click the red square and the color 
chooser will appear.) Click the Accept button and move the cursor 
the Vb track on the timeline. The cursor will have the little film clip 
icon on it like it did when we were inserting the video clip. Move the
cursor to the beginning of the timeline in the Vb track and click the l
mouse button to place the color block on the timeline. Now resize t
color block to be one second long just like we did to the transition b
placing the cursor on the right edge of the color block and sliding it
the right until it ends at 00:00:01.00 on the timeline.The timeline 
should now look like this:

The arrow in the upper left corner of the transition indicates that the
transition will go from the Va track (our video clip) to the Vb track 
(our block of color).We would like it to go the other way, so double-
click the arrow to reverse the transition.

Exporting Your New Video

Now you’re ready to produce the final result: an AVI or MPEG vide
file. Click the Export button on the timeline:
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and the Export Window appears:

Next, click on the “Configure Export Module” button to select AVI or
MPEG as the export format:
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Here we will select MPEG. Click the Accept button to return to the 
Export Window. Click save and a file dialog will appear. Save the file 
just like you do in any other application.

That’s it! You’ve just produced your first video with MainActor. Ther
are, of course, many more capabilities to explore but this chapter h
shown you just how easy it is to get started with MainActor. The ne
few chapters will explore MainActor in more detail.
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CHAPTER 4 MainActor
Video Editor
The MainActor Video Editor (or MainActor VE) module was designed to work 
with one animation at a time. While it is not as flexible or as powerful as MainAc-
tor Sequencer, it useful for many things for which MainActor Sequencer is simply 
too large and unwieldy.

In this section, you will learn to:

• Identify and use the various areas of the MainActor VE screen;

• Open and move between multiple projects;

• Convert a project from one video format to another;

• Create a slide show;

• Create an animation; and

• Extract frames from an animation.
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Starting MainActor Video Editor

To start MainActor VE, click the Windows Start button. Then, in the 
Programs directory, look for a folder called MainActor for Windows 
V3.5. In that folder, click on the MainActor icon. MainActor VE will 
load.

The Lay of the Land

The MainActor VE screen is separated into 5 distinct regions.

The Menu. The Menu contains every command available to MainAc-
tor VE. Many of the menu entries also have keyboard shortcuts (so you 
can activate a command via a key combination rather than searching 
Using MainActor
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through nested directories). See Appendix B for a detailed description 
of the menu items.

The Toolbar. The Toolbar places some of the more commonly used 
functions within easy reach. When a button is not grayed out, you may 
use it in place of an entry on the Menu.

The Toolbar features integrated fly-over help banners. If you let your 
mouse pointer hover over any button on the Toolbar, a little banner 
will appear next to it identifying the button by name.

The Project List. The Project List keeps track of how many files you 
have opened in MainActor VE.

While you can only work on one project at a time, you may have more 
than one open and ready to be worked on. Clicking on a project in the 
Project List makes it “active” and causes its contents to be listed in 
Frame List (below).

The Frame List. The Frame List displays the contents of the active 
project. When an animation is opened in MainActor VE, it is broken
down into still pictures and displayed sequentially here. This allows
you to view the animation is if it were a slide show. Whenever a fram
is highlighted in the Frame List, the picture is displayed in the previe
window (below).

The Preview Window. The Preview Window gives you an idea of 
what the finished project will look like. MainActor VE can use the Pr
view Window to play through the entire product, frame by frame, or
display individual frames.

Area Sensitive Mouse Menus. It is also possible to access certain 
commands in MainActor VE by right-clicking with your mouse over 
the different window areas. Right-clicking over the Project List, for 
example, allows you to open a new project.
nActor 31
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 Right-clicking on a project in the Project List allows you to, among 
other things, set the global timecode. 

Right-clicking on a frame in the Frame List allows you to modify its 
properties.
Using MainActor
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Getting Help
Getting Help

There will always be times when you don’t know or can’t remember a) 
what a tool does, and b) where it is. In these situations, MainActor VE 
can assist you by providing you information about the tools you’re 
using. There are two ways to get help in MainActor VE:

• Context Sensitive Help, which allows you to see some information 
on a tool or area without actually having to go into the help area, 
and

• MainActor Electronic Documentation, which is essentially an elec-
tronic user’s manual for the entire MainActor suite.

Context Sensitive Help. This is an extension of the fly-over help idea 
already present in the Toolbar. When you choose Help->Context Sen-
sitive Help from the menu, or click the Context Sensitive Help button 
on the Toolbar, your mouse changes from a pointer into a question bal-
loon. You can click this question balloon over any part of MainActor 
VE and a brief description of the area or tool, and what it is used for, 
will appear.
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MainActor Electronic Documentation. When you need to more in-
depth information than the Context Sensitive Help tool will give you, 
you can call up a complete electronic manual that covers every facet of 
the MainActor modules. Choose Help->MainActor Documentation or 
click the Show Documentation button on the toolbar to access this 
information.
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To give you an idea how MainActor VE can be used in day-to-day situations, we 
have prepared three scenarios where MainActor VE is needed to accomplish a task. 
Read the project scenarios, and then go through them on your own to familiarize 
yourself with the way MainActor VE works.

Converting Video Formats

Scenario: You’re sitting at your computer, minding your own business, when sud-
denly your boss comes storming into your cube and throws a shiny CD-ROM on 
your desk.

“This thing is in MPEG format!” he growls.

“...ok...” you say cautiously, trying not to stir him up any further. “What is it?”

The Boss sighs in irritation. “It's the commercial we filmed a few days ago. The
sent a sample of it via CD-ROM in MPEG format, and I don't have an MPEG 
player on my computer! Fix it,” he adds, and storms off.
Using MainActor 35
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You reach for your mouse, and MainActor springs to life...

A very useful aspect of MainActor VE is it’s ability to open and export 
to a huge array of animation formats. If you need to “convert” an an
mation file from one format to another, MainActor will be able to ha
dle this very capably.

Follow the directions below to convert a project from one file format 
another:

1. Start MainActor VE.

2. From the Menu, choose File->Open.

RESULT: The Select Project(s) dialog box opens.
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Converting Video Formats
 

3. In the MainActor /projects/movies directory, select admpeg. Click 
Open. 

RESULT: Admpeg appears in the Project View area, and its frames are 
listed in the Frames View.

4. From the Menu, choose File->Save As... 
nActor 37
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RESULT: The Save Window appears. (See Appendix B for a detailed 
discussion of the Save Window.)

 

5. In the Module area, make sure that AVI is selected in the list.

6. In the Codec area, choose Millions of Colors: Intel Indeo(TM) R5.0 
from the drop-down list.

7. Click All Frames.

8. Click Save...

RESULT: The Select File... window appears.
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Creating an Animated GIF
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9. Save this file in the /projects/webgif directory as adavi.

RESULT: The Select File... window closes, and the Save Window will 
count up the status of the project rendering in the Status area. When the 
rendering has finished, adavi will appear in the /projects/webgif direc-
tory.

10. When the rendering has finished, click Cancel.

11. Exit the program.

Creating an Animated GIF

Scenario: You’ve been working on your client’s website for a week or 
two, and you’re almost finished. Just as you’re about to FTP everything 
to their web server, the phone rings.

“Uhh, hello, I hope I'm not disturbing you.”

You wince as you realize that it is the client, who wants yet another 
minute change to his web site.

“Uhh, I was browsing around on the Internet the other day and I saw
this really neat site. It had a graphic that you click on to find out abo
the costs of placing advertisements on their site, and the graphic w
nActor 39
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animated, so it was really catchy. Could you whip up a nifty advertis-
ing banner real quick and put it on my home page? Don’t make it too 
big, though, I don’t want people to get tired of waiting for it to load and 
go somewhere else.”

As you hang up the phone, you sigh and reach for your mouse... an
your coffee...

One of the things MainActor VE is very good at is taking a series of 
still pictures and saving them as an animation. Of course, MainActor 
will only assemble the frames you’ve created and save them in the cor-
rect format: it’s up to you to actually create the frames that will be used 
in the animation itself.

For the purpose of this exercise, we’re going to assume you have 
already created the frames you want to use in your web graphic. These 
frames are located in the /projects/webgif directory. This procedure 
will start from the point where you’ve just finished creating the last 
frame with your trusty graphics program, and you’re ready to start 
building your animation.

1. Load MainActor VE.

RESULT: The MainActor VE Window appears.
Using MainActor
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2. From the Menu, choose File->Open.

RESULT: The Select Project(s) dialog opens.

 

3. Go to the /projects/webgif directory.

4. Select adframe0001 and click Open.
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RESULT: A dialog box appears with the message The picture is part of 
a picture list. Continue?

 

5. When MainActor sees a number of files with the same name and a 
number attached to them, it assumes that they are all intended to be 
part of the same animation and will load them in numerical order. 
Click Yes.

RESULT: The frames adframe0001 through adframe0012 are listed in 
the Frame List. A new project, named GIF, is displayed in the Project 
List.

 

6. In the Project List, right-click on GIF and click Play Project.
Using MainActor
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RESULT: The MainView module appears.

 

7. Press the play button to preview the animated GIF.

8. Close MainView.

9. Right-click on GIF and click Global Timecode. 

10. RESULT: The Global Timecode Dialog Box appears.
nActor 43



MainActor VE Projects

44

s 
al 
c-

e 
 

11. Setting the Global Timecode will affect the length of time that each 
frame is displayed before the next frame appears. Timecodes are mea-
sured in milliseconds (1/1000 of a second): for example, if you set the 
Global Timecode to “10” each frame will be shown for 10 millisecond
before being replaced by the frame that follows it. Setting the Glob
Timecode to “1000” will cause each frame to be displayed every se
ond. In the Timecode entry field, enter 1000. Click Accept.

RESULT: the Global Timecode Dialog Box closes, and the Timecod
column in the Frames List will read 1000/1000 Sec.
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Creating an Animated GIF
12. From the Menu, choose File->Save as... 

13. RESULT: The Save Window appears.

 

14. From the Module drop-down list, choose Gif-Anim.

15. Click the All Frames radio button.

16. Click Save... 

RESULT: The Select File... dialog box appears.
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Save the animation in the /projects/webgif directory as webanima.

RESULT: You are returned to the Save Window. The animated gif will 
be rendered (this may happen so quickly that you don’t notice it, 
depending on the speed of your computer. Animated GIFs are not terri-
bly hard to render and they don’t usually require much processing time.

17. Close the Save Window. 

18. To close the project without closing MainActor VE, right-click on 
GIF in the Project List and select Remove Project.

RESULT: The project is closed, but MainActor VE remains open.

Extracting Frames from an Animation

Scenario: You breathe a sigh of contentment as you look at your beau-
tiful, animated GIF. Then you choke as you realize that your beautiful 
graphic just added another 40K to the entire web site! Shaking your 
head, you realize that the GIF is at least twice as large as it needs to 
be. You’re going to have to find a way to cut that sucker in half...
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Extracting Frames from an Animation
1. Start MainActor.

2. From the Menu, choose File->Open.

RESULT: The Select Projects(s) dialog box appears.

 

3. In the /projects/movies directory, select webanima and click Open.

RESULT: webanima will appear in the Project List, its frames will be 
listed in the Frames List.

4. In the Frames List, click on frame 1.

RESULT: frame 1 will be selected.
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5. Press the CTRL key on your keyboard. While this key is pressed, 
click on frames 3, 5, 7, 9, 11 and 12.

RESULT: frames 1, 3, 5, 7, 9, 11 and 12 will be highlighted; frames 2, 
4, 6, 8, and 10 will not.

 

6. From the Menu, choose File->Save As...

RESULT: the Save Window appears.
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Extracting Frames from an Animation
 7. From the Module drop-down list, choose GIF Anim.

8. Click Selected Frames. This will cause MainActor to use only the 
frames you selected in the Frames List and discard the others.

9. Click Save...

RESULT: the Select File... window opens.
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11. Save the animation in the /projects/webgif directory as webanima2.

RESULT: The file will be rendered with only half of its original 
frames, making it roughly half the size of webanima.

12. Close the Save Window and exit the program.
Using MainActor
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Sequencer
The MainActor Sequencer module was designed to take multiple animations and 
combine them, along with text overlays and special audio and visual effects, into 
one seamless project. MainActor Sequencer is the program that gives you access to 
a very powerful video effects and processing tool set.

In this section, you will learn to:

• Identify and use the various areas of the MainActor Sequencer screen

• Insert video and audio files into tracks

• Preview your work before rendering

• Overlay text on top of a video file to create a title

• Overlay scrolling text on top of a video file to create a scrolling credits effect;

• Create 3d animated text

• “Crop” a video file

• Add effects to a video file

• Transition between one video file and another

• Add sound to your project.
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Starting MainActor Sequencer

To start MainActor Sequencer, click the Windows Start button. Then, 
in the Programs directory, look for a folder called MainActor for Win-
dows V3.5. In that folder, click on the MainActor Sequencer icon. 
MainActor Sequencer will load.

 The Lay of the Land

The Menu. The Menu contains every command available to MainAc-
tor Sequencer. Many of the menu entries also have keyboard shortcuts 
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y 
(so you can activate a command via a key combination rather than 
searching through nested directories).

The Toolbar. The Toolbar places some of the more commonly used 
functions within easy reach. The top row of buttons deals with file-
related functions (opening and saving), editing functions (cut, copy, 
and paste), and program settings. You can also access the online help 
file from the toolbar.

The second row of buttons on the toolbar is used for functions relating 
to objects in the Timeline, such as inserting objects and object proper-
ties.

The Toolbar features integrated fly-over help banners. If you let your 
mouse pointer hover over any button on the Toolbar, a little banner will 
appear next to it identifying the button by main.

 The Profile Window. The Profile Window is displayed at program 
startup and allows you to set the profiles for video and audio. The pro-
files control the type of video as well as frame sizes and rates ad audio 
quality.

The Preview Window. The Preview Window allows you to view your 
project before you export it to an animation format. When you press 
the Show Quick Preview Button (described below), the animation will 
be displayed.

Because the animation is being played “on the fly,” it will usually pla
very slowly. Also, the previewed animation will not include sound, 
even if there is sound in your project.
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The Background Renderer. The Background Renderer, when turned 
on, allows MainActor to render the animation “behind the scenes” 
while you work on other things.

The MainActor Browser. The MainActor Browser allows you to 
apply numerous fades, transitions and special effects to your anim
tion.

The Show Quick Preview Button. When this button is pressed, a pre
view of the animation project is displayed in the Preview Window.

The Timeline. The Timeline shows the various graphic, sound and te
objects that make up your project. At the top of the timeline is a sca
which is similar to the ruler used in a word processor. It indicates th
point in time for a particular location in the Timeline. This enables y
to easily tell at what point a particular part of an animation will start
and how long it will last.

Tracks. Tracks are used to hold graphic, sound, and text objects. 
Tracks extend horizontally across the timeline. The Va and Vb track
are used for transitions and effects that involve two objects, such a
fading from one graphic to another. The Fx track holds the transition
effect objects that are used by Va and Vb. The V1, V2, V3, etc. trac
are also known as Overlay Tracks because objects in them are ove
on (i.e., placed on top of) the objects in the Va and Vb tracks.

The Aa, Ab, A3, etc. tracks are the sound tracks that correspond to
video tracks. With its intuitive interface, MainActor makes it easy to
match sounds with sections of video.

The Status Area. The Status Area displays basic information about t
project -- when it starts, when it stops, and how long the animation
lasts. It can also display information such as the coordinates and n
of an object within the project.
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Getting Help

There will always be times when you don’t know or can’t remember a) 
what a tool does, and b) where it is. In these situations, MainActor 
Sequencer can assist you by providing you information about the tools 
you’re using. There are two ways to get help in MainActor Sequencer:

• Context Sensitive Help, which allows you to see some information 
on a tool or area without actually having to go into the help area, 
and

• MainActor Electronic Documentation, which is essentially an 
electronic user’s manual for the entire MainActor suite.

Context Sensitive Help. This is an extension of the fly-over help idea 
already present in the Toolbar. When you choose Help->Context Sensi-
tive Help from the menu, or click the Context Sensitive Help button on 
the Toolbar, your mouse changes from a pointer into a question bal-
loon. You can click this question balloon over any part of MainActor 
Sequencer and a brief description of the area or tool, and what it is used 
for, will appear.

MainActor Electronic Documentation. When you need more in-
depth information than the Context sensitive Help tool will give you, 
you can call up a complete electronic manual that covers every facet of 
the MainActor modules. Choose Help->MainActor Documentation or 
click the Show Documentation button on the toolbar to access this 
information.

Mouse-Keyboard Shortcuts

Moving an Object

• When the mouse is used to move an object around on the timeline, 
pressing Ctrl prior to moving the object will result in a copy opera-
tion.
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• Pressing Shift prior to moving an object on the timeline will con-
strain the object to move only vertically (i.e. between different lines 
on the timeline. The timecodes will not be changed).

Keyboard Shortcuts

These shortcuts are valid when the timeline or the main window have 
focus:

Key Action

Ctrl + I Insert Multimedia

Ctrl + E Export

Ctrl + C Copy Object

Ctrl + V Paste Object

I Set MarkIn of selected object to current time-
line position. Only for video clips.

O Set MarkOut of selected object to current time-
line position. Only for video clips.

C Toggle between Edit and Cut modes

Space Timeline play/stop

B Background rendering on/off

F Add video effect/filter

P Add video path

A Add audio effect/filter

Enter Insert 2D-Text object

Del Delete object

Esc Cancels current action

Cursor Right Move one frame forward

Cursor left Move one frame backward
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Mouse-Keyboard Shortcuts
Shift + Cursor Right Move five frames forward

Shift + Cursor Left Move five frames backward

Alt + Cursor Right Move 25 frames forward

Alt + Cursor Right Move 25 frames backward

Page Up Jump to the beginning of the timeline

Page Down Jump to the end of the timeline

Key Action
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CHAPTER 7 MainActor Sequencer 
Projects
r 
To give you an idea how MainActor Sequencer can be used in day-to-day situa-
tions, we have prepared nine scenarios where MainActor Sequencer is needed to 
accomplish a task. Read the project scenarios, and then go through them on your 
own to familiarize yourself with the way MainActor Sequencer works.

Creating a MainActor Sequencer Project

Scenario: Your boss' words hang in your mind: “Create something interesting fo
our presentation next week.”

“Like what?” you ask.

Your boss shrugs. “I don't know. Something interesting.”

In this scenario, you will:

• Insert an existing animation into a new MainActor Sequencer project;

• Add some introductory text to the beginning of the project;
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• Preview your work; and 

• Export the project to an AVI file.

For this project, we are going to use a version of the web animation 
you created in Chapter 4.

1. Start MainActor Sequencer.

RESULT: MainActor Sequencer appears, and the Profile Window 
opens.

 

2. The Profile Window allows you to define the video and audio set-
tings in your project. From this window, you can control the type of 
video, the frame sizes, frame rates, and the general audio quality of 
your project. In the listbox on the left, highlight MPEG-I Video NTSC.

3. Click Accept.

RESULT: The Profile Window closes.
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Creating a MainActor Sequencer Project
 4. From the Toolbar, click the Insert Multimedia... button.

RESULT: The Select file(s)... dialog appears.

 

5. In the /projects/movies directory, select advertise and click Open.

RESULT: The Select file(s)... dialog closes.

6. Move your mouse into the Va track.

RESULT: Your mouse pointer will change shape -- it will have a tiny 
film clip at the end of it. Also, a large gray rectangle will follow it (the 
gray rectangle represents the film clip you have just opened.)
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7. The gray rectangle will have a time signature in the upper left hand 
corner. This time signature represents when in the project the anima-
tion will start. Drag the mouse along the Va track until the time signa-
ture reads 0:00:01.00, then click on the left mouse button.

RESULT: The animation is inserted into the Va track at 0:00:01.00.

 

 

8. From the Toolbar, click the Insert 2D Text Object... button.
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RESULT: The Text Object Configuration Window and the Text Pre-
view Window appear.

 

9. In the Text Object Configuration Window, highlight the text “Main
Actor!” and replace it with the text “Introducing.”
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RESULT: The text preview window will be updated with the new 
information

10. Click Accept Text.

RESULT: The Text Object Configuration Window and the Text Pre-
view Window close.

11. Move your mouse onto the V1 track.

RESULT: Your mouse pointer will change shape -- it will have a tiny 
“T” at the end of it. Also, a gray rectangle will follow it (the gray rec
angle represents the text clip you have just created.)

 

12. The gray rectangle will have a time signature in the upper left ha
corner. This time signature represents when in the project the anim
tion will start. Drag the mouse along the V1 track until the time sign
ture reads 0:00:00.00, then click on the left mouse button.

RESULT: The text is inserted into the V1 track at 0:00:00.00.
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Creating a MainActor Sequencer Project
 

13. From the Menu, choose File->Save as...

14. Result: the Select Sequencer Project... dialog appears.

15. Save your project in the /projects directory as firstvideo, then return 
to the main screen.

16. Click the Play button on the Timeline Player.
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RESULT: the Preview Window will show you a “rough take” of what
the final animation will actually look like.

 

NOTE: The animation will look very warped and distorted. This is 
because the web animation, which was created as an ad banner 
(roughly 100 pixels wide by 60 pixels high) is being distorted to mat
the 352x288 screen size of a standard video display.

17. From the Menu, choose File->Export or click the Export button 
the toolbar
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RESULT: The Export dialog appears.

NOTE: The Export dialog has four tabs: Video, Audio, Range, and 
Crop. Each tab allows you to modify various aspects of the animation 
before you export it into a “real” video format. Video determines wh
size the animation will be and what technology will be used when t
new format is created. Audio determines the quality of the sound of 
animation (if any exists). Range allows you to specify whether you 
want to export the entire project, or only a segment of it. Crop allow
you to reduce the viewable screen area in the animation.

18. Click Save...

RESULT: The Select file... dialog appears.
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19. Save your file in the /projects/movies directory as firsttry. Click 
Save.

RESULT: the Export Progress dialog appears. When the project has 
finished exporting, the Export Progress dialog will close.

 

20. Close MainActor Sequencer

Overlaying Scrolling Text

Scenario: “Yes, well, it's very nice,” your boss tells you, “but it's miss
ing something.”
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You clench your teeth. “What exactly is it missing?” You manage to
say it without raising your voice.

“I don't know,” he says. “Maybe you could put some credits at the e
of the film.”

“Credits?” You're not as successful at keeping your voice down this
time. “At the end of a 20 second video?”

“Yeah,” your boss says, oblivious. “And make '’em scroll up like the
do in the movies. Have it ready by tomorrow, I'm going out to play 
golf.”

Creating movie-styled credits (where the list of credits scroll past the 
screen, from bottom to top) is very simple. All you need to do is enter 
the text in one 2d text window and set it to move from the bottom to 
the top of the screen.

1. Open MainActor Sequencer.

RESULT: The Profile Window appears.
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1. Click Accept.

RESULT: The Profile Window closes.

2. From the Menu, choose File->Open...

RESULT: the Select Sequencer Project appears.

 

Using MainActor



Using Mai

Overlaying Scrolling Text
3. From the /projects directory, choose firstproject.

4. Click Open.

RESULT: the project you created in the last scenario is loaded into 
MainActor. 

5. From the Toolbar, click the Insert 2D Text Object... button.

 

 

RESULT: The Text Object Configuration Window and the Text Pre-
view Window appear.
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6. Replace the text “MainActor!” with the following text (make sure t
include the spaces between the lines).

By:
Me

Animation:
Me

Direction:
Me

Storyline:
Me

Costumes:
Me
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Overlaying Scrolling Text
7. Click Enable Text Motion.

8. Set the StartX droplist to display Horizontal Center.

9. Set the EndX droplist to display Horizontal Center.

NOTE: You have just configured the text to scroll through the middle 
of the screen.

10. Set the StartY droplist to display Bottom Off Screen.

11. Set the EndY droplist to display Top Off Screen.

NOTE: You have just configured the text to scroll through the view-
able area from bottom-to-top.

 RESULT: the Text Object Configuration Window should look like 
this:
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NOTE: The Text Preview Window should be empty.

12. Click Accept Text.

RESULT: The Text Object Configuration Window and the Text Pre-
view Window close.

13. Move your mouse onto the V1 track.

RESULT: Your mouse pointer will change shape -- it will have a tiny 
“T” at the end of it. Also, a long gray rectangle will follow it (the gray
rectangle represents the scrolling text you have just created
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14. The gray rectangle will have a time signature in the upper left hand 
corner. This time signature represents when in the project the anima-
tion wills tart. Drag the mouse along the V1 track until the time signa-
ture reads 0:00:10.00, then click on the left mouse button.

RESULT: The animation is inserted into the V1 track at 0:00:10.00.

 

15. from the Menu, choose File->Save as...

RESULT: the Select Sequencer Project... dialog appears.
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16. Save your project in the /projects directory as secondvideo, then 
return to the main screen.

 17. Click the Play button on the Timeline Player.

RESULT: the Preview Window will show you a “rough take” of what
the final animation will actually look like.
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NOTE: The animation will look identical to the one you created in 
your last example, except that your scrolling credits will be tacked on 
to the end.

18. Export this file the same way you did in the last scenario, only 
name this one secondtry.

19. Close MainActor Sequencer.

Overlaying 3D Animated Text

Scenario: “Our competitor won the account. Their presentation had 
scrolling text in 3D. I think that's what clinched it.”

You force back the first twenty responses that spring to mind. Inste
you just say, “really?”

Your boss nods. “Add something in 3D to our next presentation,” he
says. “I'm going out to play golf!”
nActor 77



MainActor Sequencer Projects

78
MainActor Sequencer allows you to create three dimensional animated 
text and insert it into your project. In this scenario we will briefly 
describe how to modify a 3D animated text clip.

Because there is an awful lot you can do with 3D text, this scenario 
will give you only a general idea on how to create and insert 3D text 
into a project. We suggest you experiment with this tool yourself to get 
a good idea of the capabilities of this option.

 1. Open MainActor Sequencer.

RESULT: The Profile Window appears.

 

2. Click Accept.

RESULT: The Profile Window closes.

3. From the Button Bar, click the Insert 3D Text Object button.
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RESULT: the 3D Text Configuration Window appears.

 

NOTE: The 3D Text Configuration Window is split into several sec-
tions. The top of the window has several buttons such as the Insert Text 
button, which takes you to a dialog that will allow you to specify the 
typeface, size and message that will be rendered in 3D. Many of these 
buttons control the appearance of the rendered text such as the shading 
and rendering quality. See the online help for the details.

The bottom of the window has the Accept and Cancel buttons. Accept 
will create the 3D text based on the settings in this window. Cancel 
will close the 3D Text Configuration Window without applying any of 
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the settings. As always, you can get help for any of the parts of the 
window by clicking on the context-sensitive help button:

and then clicking on a part of the window.

In the middle of the window, just below the buttons is a set a tabs that 
allows you to control the motion of the text (if any), the light sources, 
the surface of the text, the shape of the text, and options controlling 
background and wireframe colors. Depending on the selected tab, vari-
ous things are displayed that allow you to change the properties of the 
rendered text. To the right, the Preview Pindow shows the text ren-
dered as it is currently defined, which makes it easy to experiment with 
the settings to get just the look you want.

4. Click the Options tab and then double-click the color box for Back-
ground Color. 

RESULT: The Color Selection Dialog appears:
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Select the white box in the Basic Colors list, and then press the Ok but-
ton to return to the 3D Text Window. Repeat this process to select 
black for the Wireframe Color.

5. In the toolbar, click the Left View button:

RESULT: The Preview Window will show the text from a side per-
spective.
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5. In the toolbar, click the Top View button:

RESULT: The Preview Window will show the text from an overhead 
perspective.
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NOTE: You can choose between viewing the text as a wireframe or 
from 3 different types of 3D shading by selecting the wireframe button 
or one of the shading buttons:

6. Click the Animation tab.

7. Click the Point Selection drop-down list.

RESULT: The list will show one point: Point 0.

NOTE: The Point Selection drop-down list allows you to select points 
along the path that the text will follow. At this point we have only one 
point. Now we will add another one.

8. Click the Add A New Point button:
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9. Click the Point Selection drop-down list.

RESULT: Point 1 has been added to the choices.

 

NOTE: A text path is created by selecting any of the choices in the 
Point Selection drop-down list and entering coordinates into the Coor-
dinates fields below it. By entering different locations in the start, end 
and intermediary points you give the text a series of points on a grid to 
follow. You can also select points in the Points Display box below the 
Coordinate fields and dragging them to a new location. To change the 
X-Y coordinates, click a point with the left mouse button and drag it to 
the desired location. To change the Z coordinate, click the point with 
the right mouse button and drag it.

NOTE: The position of the 3D text is determined by plotting three 
points along the X, Y, and Z axis of an invisible grid running through 
the screen. The X axis runs horizontally across the middle of the 
screen. The Y axis runs vertically across the middle of the screen. The 
Z axis controls the apparent depth or nearness of the text.

A position of (0,0,0) will place the 3D text right in the middle of the 
screen. Placing a positive number to the X field will move the text to 
the right of the X median. Placing a positive number in the Y field will 
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move the text below the Y median. Placing a positive number in the Z 
field will make the text appear farther away from you. Placing a nega-
tive number in the fields will have the opposite effect: on the X axis, 
text will move to the left of the X median; on the Y axis, text will move 
above the Y median; and on the Z axis, text will appear to be closer to 
the viewer.

10. To create a path for the text to follow, enter graph points in each of 
the Coordinate fields for each choice in the Point Selection drop-down 
list you have defined.

Here is an example of a 3D preview with X and Y axis values of 55, 
and a Z axis value of 44:

 

Here is an example of a 3D preview with X and Y axis values of -55, 
and a Z axis value of -44:
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11. To rotate the 3D text, enter the X, Y, and Z degree values in the 3D 
Rotation fields for each item in the Text Position drop-down list you 
have defined. As with text positioning, you can also rotate the text by 
selecting the point in the Points Display and using the mouse. To rotate 
about the X-axis, select the point with the left mouse button and move 
the cursor vertically. To rotate about the Y-axis, select the point with 
the left mouse button and move the cursor horizontally. To rotate about 
the Z-axis, select the point with the right mouse button and move the 
cursor vertically.

NOTE: While the entries in the 3D Position fields are mapped out as a 
grid, the entries in the 3D Rotation fields are mapped out as the degrees 
of a circle. This is because these values do not determine location, but 
rotation.

The X value determines how much the text is rotated forwards (i.e. The 
top of the text is rotated towards the screen). The Y value determines 
how much the text spins on its axis (like a globe). The Z value deter-
mines how much the text is rotated clockwise (like the hands on a 
clock).
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 Here is an example of text with X, Y, and Z rotation values of 40 
degrees:

 

12. Click the Light tab.

RESULT: The Light settings are shown.
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NOTE: This area allows you to modify aspects of the light sources. 
You can, for example, create more than one light source and place 
them in different areas on the grid. You can also change the strength, 
intensity, even the color of the light.

We will not be modifying anything here in this scenario.

13. Click the Surface tab.

RESULT: the Surface options are shown.
Using MainActor



Using Mai

Overlaying 3D Animated Text
 

NOTE: This area lets you modify the color or surface mapping of the 
text. For example, selecting Texture allows you to use a bitmap or 
other graphic as the texture of the text. Chrome maps a selected 
chrome pattern onto the text.You can also use a single color by select-
ing Color, then double-clicking the colored box to bring up the Main-
actor Color Chooser. Do so, and choose the deep purple from the Basic 
Colors list:
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14. Click Accept Text.

RESULT: The 3D Text Configuration Window closes.

15. Move your mouse onto the V1 track.

RESULT: Your mouse pointer will have a gray rectangle following it 
(the gray rectangle represents the text clip you have created).
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16. Drag the mouse along the V1 track until the time signature reads 
0:00:00.00, then click on the left mouse button.

RESULT: The animation is inserted into the V1 track at 0:00:00.00.

 

17. Move your mouse over to the right border of the text object.

RESULT: Your mouse will change shape to a double-headed arrow.

18. Drag the border of the text object to the right.

RESULT: The text object will stretch, and a time indicator (which 
measures the time that the text object ends) will appear in the upper-
right-hand corner of the gray rectangle.

 

19. When the time indicator reaches 0:00:06.00, release the left mouse 
button.
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RESULT: The duration of the text object will be lengthened to six sec-
onds. The text object will be updated accordingly.

20. Save your project.

21. Click the Play button on the Timeline Player.

RESULT: a preview of the 3D text animation will be displayed in the 
Preview Window.
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22. Export your project the same way you did in the last two scenarios, 
but name your animation 3rdtry.

23. Close MainActor Sequencer.

Adding Effects to a Video Track

Scenario: “There's a problem with this video,” your boss tells you.

“First of all, there's this black splotch at the beginning of the film. It 
really doesn't do anything. Take it out.”

“Second, lets make the beginning of the film a little bit more excitin
Put in some kind of exciting color that turns into another exciting 
color. Try using our corporate colors.”

“Orange and Aqua?” You ask in disbelief.

Your boss nods. “Yeah, I think the stockholders will like that,” he sa

“If they're color-blind,” you mutter to yourself.
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Your boss doesn’t hear you. He’s already left to play golf.

MainActor comes with many different effects that can be applied to 
animation tracks that will alter their default appearance. This scenario 
will show you how to apply special effects to your project.

1. Open MainActor Sequencer.

RESULT: the Profile Window appears.

 

2. Click Accept.

RESULT: Profile Window closes.

3. From the Toolbar, click the Insert Multimedia... button.
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RESULT: The Select file(s)... dialog appears.

 

4. This tutorial was developed using the welcome1.avi file one the 
Windows 95 CD-ROM in the /Funstuff/Videos directory. If you have 
the Windows 95 CD-ROM, you can load it from there.

RESULT: The Select file(s)... dialog closes.

5. Move your mouse into the Va track.
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RESULT: Your mouse pointer will change shape -- it will have a tiny 
film clip at the end of it. Also, a large gray rectangle will follow it (the 
gray rectangle represents the film clip you have just opened.) You will 
also notice that when you place the mouse pointer in the Va track, there 
is also a gray rectangle in the Aa audo track since the video clip also 
has audio data.

6. The gray rectangle will have a time signature in the upper left hand 
corner. This time signature represents when in the project the anima-
tion will start. Drag the mouse along the Va track until the time signa-
ture reads 0:00:01.00, then click on the left mouse button.

RESULT: The animation is inserted into the Va track at 0:00:01.00 and 
the audio information is placed in the Aa.

7. Double-click on the multimedia object in the Va track.

RESULT: the Object Settings Window opens.

NOTE: We will use the Object Settings Window to take out the black 
space that appears at the beginning of the film.

 8. Click on the slider control knob and drag it to the right.
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RESULT: the preview area of the window shows the frame of the 
video at that point.

9. Move the slider to the point near the beginning where the black 
screen begins to fade way.

RESULT: the time counter should read something close to 0:00:02.17.

10. Click the Markin button.

RESULT: the Object Settings Info Area displays the Markin position 
at 0:00:02.17, and the Markin Indicator will show a blue space in the 
area that was not marked in.

11. Click Accept.

RESULT: The dialog box closes. The track is updated so that only the 
portion of the film that was marked in is shown.

12. From the Toolbar, click on the Insert Color button.
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RESULT: The Color Plate appears.

13. From the Color Modes region, click Colorfade.

14. Click on the start color.

RESULT: the Color Selection Dialog appears.
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Adding Effects to a Video Track
15. From the User Defined Colors region, click on the orange color 
then click OK.

RESULT: the Color Selection Dialog closes. The start color in the 
Color Plate is orange.

 16. Click on the end color.

RESULT: the Color Selection Dialog appears.

17. From the user Defined Colors region, click on the aqua color then 
click OK.

RESULT: the Color Selection Dialog closes. The end color in the 
Color Plate is aqua.

18. Move your mouse onto the V1 track.

RESULT: Your mouse pointer will change shape it will have a tiny 
film clip at the end of it. Also, a gray rectangle will follow it (the gray 
rectangle represents the color fade you have just created.)

19. The gray rectangle will have a time signature in the upper left hand 
corner. This time signature represents when in the project the anima-
tion will start. Drag the mouse along the V1 track until the time signa-
ture reads 0:00:00.00, then click on the left mouse button.
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RESULT: The animation is inserted into the V1 track at 0:00:00.00.

20. Drag the right end of the color fade object on the V1 track until the 
time counter in the upper-right-hand corner reads 0:00:02.00.

 

21. Save your project in the /projects directory as colorfade, then return 
to the main screen.

22. Click the play button on the Timeline Player.

RESULT: when the Preview Window starts to play, the orange to aqua 
fade will be completely solid, and will obscure the video clip from 
view.

23. Move the orange to aqua color fade to the Vb track.
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Adding Effects to a Video Track
 24. From the MainActor Browser Window, choose Additive Dissolve 
from the Dissolve section of the Video Transitions button. 

NOTE: The MainActor Browser Window is a general-purpose toolbox 
that can perform a variety of tasks. The MainActor Browser Toolbar 
will allow you to access seven different functions: Video Transitions, 
Video Effects, Video Paths, Audio Effects, Import/Export Modules, 
Browse Your Computer, and Library.

Objects in the MainActor Browser Window can be dragged and 
dropped into a project. Depending on the object you select, you will 
sometimes add it to the Fx track (if it is an effect that transitions from 
one track to the next,) and you will sometimes add it to an object itself 
(if, for example, it is an effect that will turn a video clip from a color 
video into a greyscale video).
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Video Transitions. Video transitions enable you to create elaborate 
transitions from the Va track to the Vb track (or vice versa). 

Video Effects. Video effects allow you to perform various manipula-
tions on a clip such as warping, fading, solarizing and so on.

Video Paths. With video paths you can cause a clip to appear to follow 
a 2D or 3D path. 
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Audio Effects. The audio equivalent of Video Effects, you can take 
various options from this area and use them to modify any audio tracks 
you may have in your project.

Import/Export Modules. This part of the MainActor Browser Win-
dow gives you access to the various import and export modules for 
MainActor Sequencer to use. These modules control how multimedia 
files are loaded into MainActor Sequencer (importing) and saved to 
files from MainActor Sequencer (exporting).

 

nActor 103



MainActor Sequencer Projects

104
Browse Your Computer. This section of the MainActor Browse Win-
dow gives you access to the drives on your system as well as any net-
work drives. This enables you to access files and drop them onto the 
MainActor Sequencer Timeline.

Library. An alternate means of storing media, this allows you to keep 
a repository of clip-art-like pictures for easy accessibility.
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25. Drag the Additive Dissolve effect from the MainActor Browser 
into the 0:00:00.00 position on the Fx track.

26. Stretch the right border of the Additive Dissolve object so that it 
ends at 0:00:02.00.

27. In the Additive Dissolve object on the Fx track, double-click on the 
arrow so that it points from the color fade object to the video clip 
object.
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28. Save your project.

29. Click the play button on the Timeline Player.

30. Result: the Preview Window will show that the orange to aqua 
color fade dissolves into the video clip.

31. Export your project the same way you did in the other scenarios, 
but name your animation colorfade.

32. Close MainActor Sequencer.
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CHAPTER 8 MainActor
Video Capture
This chapter gives an introduction to MainActor Video Capture, the component of 
MainActor used with your capture hardware to input data from a video signal.

Introduction to MainActor Video Capture

Ordinary VCRs and cameras work with analog signals. To operate video with a 
computer, the signal has to be digitized, analogous to getting sound into a computer. 
This is done with an application for controlling the video converting chips (on 
either the graphics card or an extra video or TV card), and for storing the data from 
the video conversion in a video file on the computer’s hard disk.

Files

Video for Windows’ default format for storing digital video is AVI files. The AVI 
files can contain sound, too, so the sound and the pictures are in one file which sim-
plifies the handling. Single pictures can be stored in individual files (.DIB, device 
independent bitmap files), also several single pictures can be stored in sequence in 
an AVI file.
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Frames

The individual pictures in a video are called “frames”, which comes
from the pictures being “framed” with controlling signals in your TV.
The flows of picture or sound data are named “streams”. For files w
two streams of data (video and audio), the two streams can optiona
be coupled (“synchronized”) to make the pictures and the sound 
remain synchronized. Without synchronization, the video and audio
streams can drift apart during playback of the AVI file. For the video
stream, the amount of data per time is called the “frame rate” and i
measured in “frames per second.” However, for recording very slow
another way to define this measurement is the time interval betwee
two frames: “seconds per frame”.

Video Format

Video signals can have several formats, the most well known are 
NTSC and PAL. The resolution for capturing can be selected (e.g. 
640x480 or 320x200). This resolution is the capture chip's output a
digitizing the input signal's original resolution.

Audio Format

The audio signal is one or two wave signals (Stereo or Mono), the 
“height” of the wave is sampled with a “sampling frequency”. The re
olution of the sampling is given as the “sample size” e.g. a standar
audio CD uses two audio data streams for Stereo, a sampling frequ
of 44.1 kHz and a resolution of 16 bits.
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The Video Capture Application

The Lay of the Land

The window of the capture application contains the video picture, a 
toolbar, and a menu.

In the menu all the commands for controlling the video capturing are 
contained. In the “File” menu you can call up the file name dialogs 
frame capture and video capture. The “Source” menu lets you selec
input device for the video capture. The “Capture” menu has the item
for starting the capturing. With the “Settings” menu you can control t
video and audio formats and other properties.

The toolbar contains the most-used items of the menu, and is divid
into four partitions. From left to right, these are: frame capture, vide
capture, view control and capture options (the frame rate, and audi
capture enabling)

How to view the input signal

Video for Windows supports two modes of viewing the input signal:
“Overlay” is the original signal, as detected by the video chips, “Pre
view” is the signal converted to the frame rate selected in the toolb
rightmost partition. To select a frame rate, use the button with the s
watch to select between “frames per second” and “seconds per fram
and then set the numeric entry left of that button to the desired valu

How to capture a single frame

The leftmost part of the toolbar contains the buttons for Frame Cap
ture. With the left button the file name is selected. Then the current
frame can be captured by clicking on the right button (camera to fil
with a frame in the upper right).
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How to capture a frame sequence

In the second partition, there are four buttons. With the left button, the 
file name for capturing the frames is entered. With the third button 
(camera to frame, with the video symbol in the upper right), the captur-
ing of the frames sequence is started and ended. After starting the 
sequence capture mode, the fourth button (frame to file with a video 
symbol in the upper right) is then used to capture the current frame to 
the AVI file.

This manually selects frames for saving sequentially in the video file.

How to capture video

Like capturing a frame sequence, the buttons of the second toolbar are 
employed to capture video. After setting the file name with the first 
button, the second button (camera to file, with the video symbol in the 
upper right) starts capturing the video signal continuously. The capture 
is ended with pressing the ESC key.

This is an automatic frame capture, which uses the frame rate from the 
tool bar as does the “Preview”.

Settings

There are six dialogs to manipulate the settings of the capture app
tion: “Audio-Format”, “Video-Format”, “Video-Source”, “Video-Dis-
play”, “Video-Compression”, “Other Video-Settings”. These dialogs
are dependent on the device driver which is controlling the capture
device you selected in the menu “Source”.
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Video Capture Tutorial

First, you should check that your equipment is connected and switched 
on. The video input can be easily monitored by using the “Overlay”
function, which is started by pressing the toolbar button with the ey
and the camera. (Or, if the overlay function is unavailable, use the 
“Preview” button beside the “Overlay” button). If there is no picture,
the next step would be to select the video input device (the comput
hardware that receives the video signal), by opening the “Source” 
menu, and clicking on the menu entry for the desired menu entry.

If the picture is warbled, or there is still no picture, there might be a
mix-up between NTSC and PAL for the video signal and the video 
input device. That is, the signal might be PAL when the input device
trying to detect NTSC or vice versa. The result is that the input dev
can't synchronize with the video signal. This can be remedied by us
the “Settings” menu and selecting “Video Source” to open the devic
source dialog. In the source dialog, you can set the video signal's f
mat to PAL, NTSC or SECAM, select the connector of the device 
which the video input is connected to, and correct the color settings
the signal.

The next step should be selecting the desired resolution of the pict
This is done with the “Video Format” dialog in the “Settings” menu. 
This dialog lets you select the resolution of the digitized video data
(e.g. 640x480 pixels), the color depth (e.g. RGB 16-bit = 65536 col
ors), and possibly have the signal mirrored horizontally.

Now that the signal is configured, the next thing is the frame rate (h
many pictures you record per second). You enter the frame rate in 
numeric entry in the toolbar's rightmost partition, e.g. if you want to
record ten frames (=video pictures) each second, you enter 10 her
Right of the numeric entry field is a button with a movie and a stop-
watch, where an arrow points from the movie to the stopwatch to in
cate “frames per second” or from the stopwatch to the movie for 
“seconds per frame”. For ten frames each second, you select the 
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“frames per second” setting of this button then set the numeric valu
10. “Seconds per frame” is the inverse measuring scale: the time 
between two frames is entered in the numeric field; lets say you wa
one frame every five seconds: you would push the button to indica
“seconds per frame” then enter 5 in the numeric field.

At this point everything is set except for the name of the file which w
hold the captured data. The second toolbar partition holds four butto
The leftmost button (with the document “ab” and the movie symbol
starts a dialog that lets you select or enter the file name.

The second button (with the movie symbol, where an arrow points 
from a camera to a document symbol) starts the capturing. Below t
video view, in the status line of the capture window, the device displ
how many frames have been captured (dropped frames are pictures
were lost during the process of capturing and are obviously not sav
in the capture file).

Capturing is ended by pressing the ESC key. The application show
total in the status line, and the file is saved to disk (the data writing
might lag somewhat with high frame rates).

Video Capture Tips

Now that you have done a capture, here's some more detail on par
ters to set up for capturing video.

The most important thing to consider is compression, since a single
frame of 640x480 pixels with 16-bit colors is already 614 Kilobytes,
adding CD quality sound to a video of 30 fps (frames per second) gi
you a total of 18.6 MBytes each second! For a disk space of 1 
Gigabyte, this space is used up after about 54 seconds!
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So, to save disk space and disk writing time (not every hard disk can 
write 18.6MB/s; some top models for PC’s reach 5-8MB/s; the average 
hard drive writes around 2-3MB/s), you must select a compression. 

Video compression works differently than other compressions you may 
be familiar with such as Zip. Compression can be either lossless or 
lossy. The Zip compression scheme is a lossless compression scheme 
because uncompressing compressed data results in exactly the original 
data. In other words, lossless compression is fully reversible. This 
reversibility is necessary if you want to read a document that was 
ZIPped on another computer. Video (and audio) compressions can’t be 
efficiently compressed with lossless schemes because they are simply 
too inefficient, making the achievable compression on video (and 
audio) too low. So video (audio) compression is done with lossy com-
pression schemes which exploit limitations of the human eye (and ear) 
to reduce the amount of data that has to be stored without the eye (or 
ear) noticing much of a difference. Thus, uncompressing data that were 
compressed with a lossy scheme does not result in exactly the original 
data. Some of the information is thrown away but you can tune how 
much information is removed via the quality setting of the compression 
scheme.

MainActor Video Capture can also use video compression when cap-
turing video input. Normally, full (=uncompressed) frames are saved in 
the AVI file, but with “Video Compression” from the “Settings” menu
you can select one of the installed codecs (COmpressor/DECompr
sor modules). Besides the “Microsoft Video” and “Index” codecs, yo
may also use “MCMJPG”, the Motion-JPEG codec from MainCon-
cept.

The “Video Compression” dialog consists of a select box for selecti
the codec, a slide for changing the quality/reduction percentage, an
allows setting the key frames. Some video compressions start with
key frame derived from a full frame, and compress only the differenc
of the next, “incremental” frames from there. To reduce computing 
load, you can use a greater distance between key frames and thus 
incremental frames. For better reproduction, especially when the vi
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pictures are rapidly changing, you can use a smaller number of incre-
mental frames between the key frames.

The quality setting gives a crudely calculated percentage of quality 
against uncompressed frames. A higher quality setting means better 
quality but lower data compression. A lower setting means more 
reduction and thus lower quality. A PC with a Pentium II at 333MHz, 
using our MJPG codec at 50% quality setting, captures and compresses 
a 640x480, 16-bit video at 15fps (~9MB/s) of 38 seconds to a file of 
37MB file size, about 1MB/s, that’s a compression rate of 1:9 which 
allows for using standard IDE hard disks. Your results might vary of 
course. 

Another important consideration is capturing both video and audio. 
That means, besides having a video signal connected from your VCR 
or camera to your computer’s video input hardware, you must connect 
an audio signal from the VCR, camera or a microphone. You enable 
mixed video and audio capturing either with the rightmost button in the 
toolbar (with the movie and loudspeaker symbols), or with the “Oth
Video Settings” dialog from the “Settings” menu. In the “Other Vide
Settings” dialog, you can also enable synchronizing the video and 
audio data in the capture file. During playback, the video and the au
data streams can drift apart, and synchronizing stops this drift, but 
might also reduce sound or picture quality during playback.

Besides enabling sound recording with the audio capture button, yo
can also manipulate the capturing of audio data with “Audio Forma
of the “Settings” menu. Analog audio is a wave signal, to digitize the
waves, the audio hardware (mostly: your sound card) takes a “sam
and compares it to a reference, this comparison is measured with a
olution - the “sample size” of either 8-bit or 16-bit. The rate with whic
the computer takes the samples is the “sampling rate” (e.g. 44.1 kH
for CD quality). Also you must select between Mono and Stereo sa
pling (one or two audio channels). So, to record sound with CD qua
you'd use Stereo, 44.1 kHz sampling with 16-bit; FM radio-like sou
is about 22.05 kHz,16-bit Stereo (half the data of CD quality),
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and telephone “quality” you get with 8 kHz -11.025 kHz, 8-bit Mono
(one sixteenth of the data CD quality generates).
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This chapter gives an introduction to MainActor DV-Capture, the component of 
MainActor used with your DV (digital video) hardware to capture data from a 
video source.

What is Digital Video?

Over the past twenty years, VCR’s and camcorders have become very popula
devices. Only recently, however, have digital models become widely available
These new models have advantages over the older analog ones, similar to the
advantages that CD audio disks hold over cassette or vinyl records. 

A digital signal will give a better representation of the recorded data and the qu
of the data will not degrade through multiple copies. And, since computers are
ital devices, digital data are already in a form suitable for manipulation with so
ware like MainActor. You don’t need a traditional video capture board because
purpose is to convert an analog signal to a digital signal.
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What Do I Need to Use DV-Capture?

To use MainActor DV-Capture, you need the following:

• a digital video (DV) device such as a DV camcorder

• Windows 98 SE or Windows 2000

• a Firewire card and appropriate cable to interface the DV device 
with your computer

Using MainActor DV-Capture

The MainActor DV-Capture program has an intuitive interface that 
allows you to easily capture the signal from a DV device. Some DV 
devices can also be controlled from the DV-Capture program, making 
it very easy to perform a video capture. Consult the documentation for 
your DV device to see if it supports remote control.

The DV-Capture window provides flexible access to your DV device 

through menus, buttons, and hotkeys. For many functions, there are 
multiple ways of accessing them.
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The Menu

The menu provides access to the following functions:

• Setting the path and name of the file that the captured video will be 
written to

• Selecting the DV device to be used for capturing

• Starting and stopping the capture

• Exiting the program

Remote Control

If your DV device supports remote control, you can use the buttons in 
this part of the window to control it.

Each button is used as follows:

Rewind and fast-forward buttons

Pause button
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Step forward or backward by a single frame

Search forward or backward

Start playing and stop playing the video

The Capture Control

These buttons control the capturing of the video stream to your hard 
disk.

The button on the left starts the capture and the one on the right stops 
it. Hotkeys are also available for these functions: Ctrl+R to start 
recording and Ctrl+S to stop.

Since a DV data stream is digital, MainActor DV-Capture more or less 
copies the data stream directly to your hard drive. The format of the 
data file is AVI (Type 2) with separate video and audio layers.
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Capture File Name

In addition to the menu, you can use this section of the window to set 
the path and name of the file that the captured data will be written to.

Click the disk icon to browse the files on your computer.

DV-Capture Tutorial

This section gives you step by step instructions on using DV-Capture. 
To capture video from a DV camcorder, make sure that you have the 
minimum requirements mentioned previously on page 118.

1. Plug one end of your DV cable into your Firewire card:

2. Turn on the camera, and plug the other end of the dv-cable into the 
camcorder.

3. Now your system will detect that a dv source is connected to the 
computer. This will take a few seconds.
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4. Start MainActor DV-Capture.

5. If you have more than one DV-Source you can select the source in 
the capture device menu. 

6. Select the filename you want to use for your capture by clicking the 
disk-symbol:

Note: 1 second of video capture is about 4 megabytes in size, so 
choose a fast partition of your hard drive with plenty of free space. 
Under Windows 98, the maximum size of the capture files is 4 
gigabytes, or about 19 minutes of video.

7. If your camcorder supports remote control, press the play button in 
the Remote Control section of the DV-Capture window:

If your camcorder does not support remote control, press the play but-
ton on your camcorder. You will get a preview of your video in the 
DV-Capture window

8. Press the record button in the Capture Control section:
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There is no preview available while DV-Capture is capturing your 
video from the camcorder to your hard disk.

9. Stop the capture after half a minute, and close DV-Capture. 

Now you can edit the captured video by importing it into MainActor 
Sequencer. Once you have edited the video, you can put it onto tape 
using MainActor DV-Out as decribed in the next chapter.
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CHAPTER 10 MainActor
DV-Out
This chapter gives an introduction to MainActor DV-Out, the component of Main-
Actor used to send a digital video stream to your DV (digital video) hard-
ware.Using DV-Out, you can record videos created with MainActor on a DV 
device such as a DV camcorder.

What Do I Need to Use DV-Out?

To use MainActor DV-Out, you need the following:

• a digital video (DV) device such as a DV camcorder

• Windows 98 SE or Windows 2000

• a Firewire card and appropriate cable to interface the DV device with your com-
puter
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Using MainActor DV-Out

MainActor DV-Out performs the complementary task of MainActor 
DV-Capture. DV-Capture is used to import digital video into MainAc-
tor. DV-Out is used to send digital video to a DV recording device. 
Because their functions are similar, you will notice that they both work 
in similar ways.

 If you have suitable equipment, you will probably use both programs 
on a project: record a video with your DV camcorder, import it to your 
computer using MainActor DV-Capture, use MainActor Sequencer to 
add transitions and effects, and then use MainActor DV-Out to record 
your video onto tape. With MainActor and a DV camcorder, you 
instantly become a filmmaker!

The main window of DV-Out provides easy access to the functions 

used to send digital video data to your DV device. Below are the func-
tions and how they are accessed.
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The Menu

The menu provides access to the following functions:

• Setting the path and name of the file that will be sent to the DV 
device

• Selecting the DV device (or a file) for output

• Starting and stopping the recording

• Exiting the program

If you send the output to a file, the current AVI file will be converted. 
AVI Type 1 will be converted to Type 2 and vice versa.

Remote Control

If your DV device supports remote control, you can use the buttons in 
this part of the window to control it. Not all camcorders have remote 
control capabilities. If yours does not, you will have to manually set 
the tape position to the place where you want to begin recording.

Each button is used as follows:

Rewind and fast-forward buttons
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Pause button

Step forward or backward by a single frame

Search forward or backward

Start playing and stop playing the video

The Playback Control

These buttons control the capturing of the video file to your DV 
device.

The symbols used on the playback buttons look like the ones you are 
used to using on a camcorder or VCR. The button on the top row by 
itself is used to pause the playback. 

The second row has three buttons that, from left to right, are the 
Record, Play and Stop buttons. Use the record button to start recording 
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your file to the DV device. The play button will start playing the video 
without recording it to tape, useful if you want to put only part of a 
video file onto tape. The stop button will stop the playback of the video 
file.

There is no preview of the video in the DV-Out window. This is nor-
mally done on the camcorder display.

Recorded File Name

In addition to the menu, you can use this section of the window to set 
the path and name of the file will be recorded by your DV device.

Click the folder icon to browse the files on your computer and select 
the one to be recorded.

DV-Out Tutorial

You can edit the clip, or clips you captured with DV-Capture in Main-
Actor Sequencer. If you want to output the resulting video to a DV 
source you have to do the following in MainActor Sequencer 
Sequencer:

1. Choose one of the DV profiles:
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2. Import your videoclips into the timeline and edit them as you wish.

3. After you have done your work on the clip, you can export it using 
the Mainactor DV Codec. Go to "Export" and choose the MainActor 
export module:
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4. Click the "Configure Export Module" button, and choose "AVI-
Mainconcept DV SoftCodec:

5. Now click “Accept”, and export the file onto your hard disk.

6. Ensure you have connected the DV cable to your computer and c
corder. 

7. Turn the camera on.

8. Start MainActor DV-Out.

9. Choose the file you exported onto the harddrive by clicking on th
folder icon:

10. If your camcorder supports remote control, you can use the Rem
Control buttons to find the position on the tape where you want to 
record the video:
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If your camcorder does not support remote control, you will have to 
position the tape at the correct point using the buttons on the cam-
corder.

11. With a remote-control capable camcorder, you can save directly to 
tape by clicking the "Play Record" button:

If your camcorder has no remote-control support you will have to press 
the record button on your camcorder manually before you press the 
play button in DV-Out.
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Formats
This section lists all the graphic, animation and multimedia file formats supported 
by MainActor. Individual discrepancies and special information on each file format 
are also listed here.

These modules are used by MainActor VE. MainActor Sequencer also uses these 
modules through the MainActor Import/Export modules but also supports the 
Video for Windows, DirectShow and RealVideo APIs. MainActor Sequencer also 
has an import module (Tracker) that supports FastTracker 2, ScreamTracker 3, 
MultiTracker, Oktalyzer, TakeTraker Pro, Pro Tracker, and Impulse. The various 
modules can be selected from the program toolbar. The module used by the "Insert 
Multimedia..." toolbar button can be changed in the program preferences and 
defaults to the MainActor module.

The supported files in MainActor are listed by Module type (AVI, GIF, etc.). Each 
entry lists the Codec choices that each Module type supports, and the Saver Mod-
ules information also lists what specific properties can be set in the Module Options 
window.
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Loader Modules

These File Formats can be loaded into and played by MainActor.

8SVX

Type: Sound
Codecs Supported:

• 8-bit: uncompressed

• 8-bit Fibonacci-delta encoding

• 8-bit Exponential-delta encoding

AU

Type: Sound
Codecs Supported:

• A-Law Encoding

• U-Law Encoding

• 8-bit: Linear

• 16-bit Linear

• 32-bit Linear

AVI

Type: Animation (plus Sound)
Codecs Supported:

• 16 Colors: Uncompressed

• 256 Colors: Microsoft RLE

• 256 Colors: Microsoft Video 1

• 256 Colors: Uncompressed

• Thousands of Colors: Microsoft Video 1
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• Millions of Colors: Cinepak(TM) Radius

• Millions of Colors: Intel Indeo(TM) R2.1

• Millions of Colors: Intel Indeo(TM) R3.1

• Millions of Colors: Intel Indeo(TM) R3.2

• Millions of Colors: Intel Indeo(TM) Raw

• Millions of Colors: Motion JPEG

• Millions of Colors: Ultimotion(TM) IBM

• Millions of Colors: Uncompressed

BMP

Type: Picture
Codecs Supported:

• 2 Colors: Uncompressed

• 16 Colors: Uncompressed

• 16 Colors: RunLength Encoded

• 256 Colors: Uncompressed

• 256 Colors: RunLength Encoded

• Millions of Colors: Uncompressed

• Millions of Colors: RunLength Encoded

DL

Type: Animation
Codecs Supported:

• 256 Colors: Type 1

• 256 Colors: Type 2
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FLC

Type: Animation
Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: Bye LineCoding

• 256 Colors: Clear Screen

• 256 Colors: Uncompressed

• 256 Colors: Word LineCoding

FLI

Type: Animation
Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: Byte LineCoding

• 256 Colors: Clear Screen

• 256 Colors: Uncompressed

GIF

Type: Picture
Codecs Supported:

• 256 Colors: GIF-LZW

GIF - Anim

• Type: Animation

• Codecs Supported:

• · 256 Colors: GIF-LZW
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IFF

Type: Picture
Codecs Supported:

• 256 Colors: ByteRun

• Millions of Colors: ByteRun

IFF - Anim3

Type: Animation
Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: Delta3

IFF - Anim5

Type: Animation

Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: Delta5

IFF - Anim7

Type: Animation
Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: Delta7_16

• 256 Colors: Delta7_32
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IFF - Anim8

Type: Animation
Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: Delta8_16

• 256 Colors: Delta8_32

IFF - AnimJ

Type: Animation
Codecs Supported:

• 256 Colors: ByteRun

• 256 Colors: DeltaJ

JPEG

Type: Picture
Codecs Supported:

• Millions of Colors: JPEG

MPEG

Type: Animation
Codecs Supported:

• Millions of Colors: MPEG-1

• Millions of Colors: MPEG-2
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MPEG-Audio

Type: Sound
Codecs Supported:

• 16 Bit: Audio Layer I

• 16 Bit: Audio Layer II

• 16 Bit: Audio Layer III

PCX

Type: Picture
Codecs Supported:

• 16 Colors: RunLength Encoded

• 256 Colors: RunLength Encoded

• Millions of Colors: RunLength Encoded

PNG

Type: Picture
Codecs Supported:

• 2 Colors: Compressed

• 16 Colors: Compressed

• 256 Colors: Compressed

• Millions of Colors: Compressed

PPM,PGM,PBM

Type: Picture
Codecs Supported:

• Millions of Colors: Uncompressed, P6/P3, *.PPM
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• 256 Graylevels: Uncompressed, P5/P2, *.PGM

• Black & White, Uncompressed, P4/P1, *.PBM

QuickTime

Type: Animation (plus Sound)
Codecs Supported:

• 256 Colors: Apple Animation

• 256 Colors: Apple Graphics

• 256 Colors: Uncompressed

• Thousands of Colors: Apple Animation

• Thousands of Colors: Apple Video

• Thousands of Colors: Uncompressed

• Millions of Colors: Apple Animation

• Millions of Colors: Cinepak(TM) Radius

• Millions of Colors: Intel Indeo(TM) R2.1

• Millions of Colors: Intel Indeo(TM) R3.1

• Millions of Colors: Intel Indeo(TM) R3.2

• Millions of Colors: Intel Indeo(TM) Raw

• Millions of Colors: Motion JPEG

• Millions of Colors: Uncompressed

TGA

Type: Picture
Codecs Supported:

• 256 Colors: RunLength Encoded

• 256 Colors: Uncompressed

• Thousands of Colors: RunLength Encoded
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• Thousands of Colors: Uncompressed

• Millions of Colors: RunLength Encoded

• Millions of Colors: Uncompressed

WAV

Type: Sound
Codecs Supported:

• 8/16 Bit: Pulse Code Modulation

Saver Formats

MainActor VE can save projects into the following file formats.

AVI

Type: Animation
Codecs Supported:

• 256 Colors: Microsoft RLE

• 256 Colors: Uncompressed

• Millions of Colors: Intel Indeo(TM) R3.1

• Millions of Colors: Motion JPEG

• Millions of Colors: Ultimotion(TM) IBM

• Millions of Colors: Uncompressed

Module Options:

• Codec Quality (1-100), Default -1

• Codec Keyframe Rate (1-1000), Default -1
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• Disable Audio (save video only) ON/OFF

AVI uses global timecodes. If you encounter an AVI animation which 
MainActor VE does not play correctly (or uses a codec unknown by 
MainActor VE) please contact MainConcept.

BMP

Type: Picture
Codecs Supported:

• 256 Colors: Uncompressed

• 256 Colors: RunLength Encoded

• Millions of Colors: Uncompressed

• Millions of Colors: RunLength Encoded

Module Options:

• Use old OS/2 1.x/Windows 2.x header if possible OR

• Use Windows 3.0 header if possible (Default) OR

• Always use OS/2 2.0 header

FLC

Type: Animation
Codecs Supported:

• 256 Colors: Word LineCoding

FLC animations are limited to 256 colors and use global timecodes.
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FLI

Type: Animation
Codecs Supported:

• 256 Colors: Byte LineCoding

FLI only supports 320x200 images. FLI animations are limited to 256 
colors and use global timecodes.

GIF

Type: Picture
Codecs Supported:

• 256 Colors: GIF-LZW

Module Options:

• Interlace ON/OFF

• Color Index Values (0-255), Background Index, Default 0

• Color Index Values (0-255), Transparent Index, Default 0

GIF supports 256 colors only. The LZW decoding/encoding is offi-
cially licensed from UniSys.

GIF - Anim

Type: Animation
Codecs Supported:

• 256 Colors: GIF-LZW

Module Options:

• Interlace ON/OFF
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• Color Index Values (0-255), Background Index, Default 0

• Color Index Values (0-255), Transparent Index, Default 0

• Netscape Loop, Default 10 ON/OFF

Animated GIFs support local timecodes, so it is possible to convert 
AVI or Quicktime animations to GIF-Anim without loss of timing 
information. GIF supports 256 colors only. The LZW decoding/encod-
ing is officially licensed from UniSys.

JPEG

Type: Picture
Codecs Supported:

• Millions of Colors: JPEG

Module Options:

• Compression Quality, Default 75

MacPICT

Type: Picture
Codecs Supported:

• 256 Colors: RunLength Encoded

• Thousands of Colors: RunLength Encoded

• Millions of Colors: RunLength Encoded

MPEG - Audio

Type: Sound
Codecs Supported:

• 16 Bit: MPEG-Audio Layer I
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Module Options:

• Audio Bitrate, Default 128 kb/s

• Audio Sampling Rate, Default 41.100

• Audio Checksums (error protection) ON/OFF

The Audio file is split into 1 seconds parts when loaded into MainAc-
tor VE. This makes it easier to access specific parts of the audio file.

MPEG - I

Type: Animation
Codecs Supported:

• Millions of Colors: MPEG-I NTSC (30 fps)

• Millions of Colors: MPEG-I PAL (25 fps)

• Millions of Colors: MPEG-I FILM (24 fps)

Module Options:

• Video Bitrate, Default 1151000

• Ignore MPEG-I Video Limit ON/OFF

• Audio Bitrate, Default 128 kb/s

• Audio Sampling Rate, Default 41.100

• Audio Checksums (error protection) ON/OFF

• Ignore Audio (save audio only) ON/OFF

This is the best option for MPEG-I encoding with MainActor VE.

MPEG - I/II

Type: Animation
Codecs Supported:
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• Millions of Colors: MPEG-I NTSC (30 fps)

• Millions of Colors: MPEG-I PAL (25 fps)

• Millions of Colors: MPEG-II NTSC (30 fps)

• Millions of Colors: MPEG-II PAL (25 fps)

Module Options:

• MPEG-I Video Bitrate, Default 1151000

• MPEG-II Video Bitrate, Default 5000000

• Interlace ON/OFF

• Top Field, Default 0

• Audio Bitrate, Default 128 kb/s

• Audio Sampling Rate, Default 41.100 kb/s

• Audio Checksums (error protection) ON/OFF

PNG

Type: Picture
Codecs Supported:

• 256 Colors: Compressed

• Millions of Colors: Compressed

Module Options:

• Adam7-Interlaced ON/OFF

PPM,PGM,PB

Type: Picture
Codecs Supported:

• P6 - Millions of Colors: Raw & Uncompressed, *.PPM
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• P5 - 256 Graylevels: Raw & Uncompressed, *.PGM

• P4 - Black & White: Raw & Uncompressed, *.PBM

• P3 - Millions of Colors: ASCII & Uncompressed, *.PPM

• P2 - 256 Graylevels: ASCII & Uncompressed, *.PGM

• P1 - Black & White: ASCII & Uncompressed, *.PBM

QuickTime

Type: Animation
Codecs Supported:

• Millions of Colors: Intel Indeo(TM) R3.1

• Millions of Colors: Motion JPEG

Module Options:

• Codec Quality (1-100), Default -1

• Codec Keyframe Rate (1-1000), Default -1

• Disable Audio (save video only) ON/OFF

Quicktime supports local timecodes. If you encounter a Quicktime ani-
mation which MainActor VE does not play correctly (or uses a codec 
unknown by MainActor VE) please inform MainConcept.

TGA

Type: Picture
Codecs Supported:

• 256 Colors: RunLength Encoded

• 256 Colors: Uncompressed

• Thousands of Colors: RunLength Encoded

• Thousands of Colors: Uncompressed
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• Millions of Colors: RunLength Encoded

• Millions of Colors: Uncompressed

Video Data

Type: Picture
Codecs Supported:

• Binary: Video Frame Data

This format splits the compressed video data from animations. It is 
very useful to save standalone image data from animation formats. For 
example, motion JPEG AVIs and Quicktime animations contain stan-
dalone JPEG image data for each frame. using this aver module you 
can save them into single files without having to decompress and then 
compress them again.

WAV

Type: Sound
Codecs Supported:

• 8/16 Bit: Pulse Code Modulation
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APPENDIX B MainActor VE
Command Reference
This section explains how to use all of the MainActor VE tools and commands.

Introduction

Instead of being listed in alphabetical order, the commands are organized by how 
they appear on the MainActor VE screen. For example, the Open, Close, Save As, 
Close All and Exit commands are accessed though the File menu, so they are found 
in the "File" listing under Menu List Commands. The Open, Close, and Save As 
commands are also buttons on the toolbar, so they are mentioned under Toolbar 
Commands as well.

Menu List Commands

All of the following commands are accessible from the MainActor VE menu:
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File

Open... [Alt+O].

This command will cause a standard file dialog box to open, allowing 
you to load an animation into MainActor VE as a project. It is possible 
to load more than one file into MainActor VE simultaneously.

Close [Alt+S]

This command will close the project without saving any changes made 
while it was open.

Save As... [Alt+A]

When you’re ready to save a project, the Save As... command will open 
the Save Window. This dialog box allows you to determine what file 
format the project will use, to modify some general characteristics of 
the animation, and of course actually save the file.

Close All [Alt+L]

This command is similar to the Close command above, but it will close 
every project loaded into the project area at once, not just the one that 
is currently active.

Exit [Alt+E]

This command will close the MainActor VE window and end the pro-
gram. This command will not prompt you for verification, and if you 
have loaded any projects into MainActor VE they will be closed with-
out being saved.
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Edit

Copy to Clipboard

Copies the selected information into the clipboard. If you select a 
frame and copy it to the  clipboard, you can paste it anywhere, in any 
application.

Select

While you can use your mouse to select an individual or a series of 
frames, (and use can use your mouse plus the Ctrl button to select mul-
tiple frames out of series), you can also select project frames via the 
MainActor VE window.

All {Alt++]

This command selects (highlights) every frame in your project.

Range...

This command will open the Select Range dialog box, allowing 
you to specify a series of frames to be highlighted. The parts of 
this dialog box are as follows:

From

This field specifies what frame will be the first frame to be 
selected. It defaults to the first frame in the project.

To

This field specifies what frame will be the last frame to be 
selected. It defaults to the last frame in the project.
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Accept

Clicking this button will select the frame specified in the 
"From" field, the frame in the "To" field, and every frame in 
between.

Cancel

Clicking this button will close the Select Range dialog box 
without selecting any frames.

Help

Opens the Help dialog.

Compression...

After you have selected a series of frames, the Select Compression 
dialog box lets you select the frames in the Frame List which have 
a specific compression method.

Compression Format field

This area will list what compression formats are available for 
use on the selected frames. Selecting the compression format 
and clicking on the "accept" button will apply that format to 
the selected frames.

If there is more than one possible format to choose from, only 
one can be selected.

Accept

Clicking this button will apply the chosen file compression 
format to the selected frames.
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Cancel

Clicking this button will close the Select Compression dialog 
box without selecting any frames.

Help

Opens the Help dialog.

Deselect

When a series of frames are selected, these commands can deselect all 
of them, some of them, or decompress them if they are compressed.

All [Alt+-]

This command deselects every frame in your project.

Range...

This command will open the Deselect Range dialog box, allowing 
you to specify a series of frames to be deselected.

From

This field specifies what frame will be the first frame to be 
deselected. It defaults to the first frame in the project.

To

This field specifies what frame will be the last frame to be 
deselected. It defaults to the last frame in the project.
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Accept

Clicking this button will deselect the frame specified in the 
"From" field, the frame in the "To" field, and every frame in 
between.

Cancel

Clicking this button will close the Deselect Range dialog box 
without deselecting any frames.

Help

Opens the Help dialog

Compression...

After you have selected a series of frames that use a graphics for-
mat that utilizes compression, the Deselect Compression dialog 
box lets you remove the compression from those graphics.

Invert [Alt+V]

This command will switch frames that are selected with frames 
that are not selected: the frames that are selected will become 
unselected, and the frames that are unselected will become 
selected.

Capture Video...

Opens the Video Capture window. See Chapter 7 for information 
on video capture.
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Project

Project Info... [Alt+I]

This command opens the Project Info window, which displays 
basic information about your MainActor VE project.

Name

The name of the project file.

Format

The animation or graphic format of your project file (i.e., 
MEPG or JPEG).

Width

The width (in pixels) of the frames in your project.

Height

The height (in pixels) of the frames in your project.

Frames

The number of frames in your project.

Loop Frames

The number of times you have set the frames in your project 
to loop.
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Average Image Size

The average size, in bytes of each frame in your project.

Average Sound Size

The average size, in bytes, of the sound file per frame.

Sample mode

The way the sound was recorded (mono or stereo).

Bits Per Sample

The number of bits per sample, typically 8 or 16 bits. The 
sound quality improves with the number of bits. This field is 
empty when no sound is associated with the project.

Samples Per Second

The samples which are played per second (in Khz). More 
samples are equivalent with better sound quality. This field is 
empty when no sound is associated with the project.

Total Project Size

The size, in bytes, of the project.

Color Space Spec

The color space format of the project.
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Global Timecode... {Alt+G]

This command allows you to change the timecode an animation. 
Changing the timecode alters how long each frame is displayed in 
an animation before the next frame takes its place. Timecodes are 
set in milliseconds -- a 20 frame animation with a global timecode 
setting of "4" would take a total of 80 milliseconds to run.

Enter Timecode field

The number entered into this field will define the local time-
code in milliseconds.

Accept

Clicking this button will apply the local timecode as defined 
in the Enter Timecode field.

Cancel

Clicking this button will close the Local Timecode window 
without changing the default timecode.

Help

Opens the Help dialog.

Cache Data [Alt+C]

This command loads the entire project into RAM, which results in 
better access and playback times. If the menu item is checked, the 
data is cached in memory. If not, the data will be loaded directly 
from disk (this is the default for all projects.)
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Not all loader modules support caching. If a loader module does 
not support caching, the menu item is disabled. This is the case for 
most of the picture loader modules.

Play Project... [Alt+P]

This command loads the entire project into MainView.

Remove Project... {Alt+R]

Closes the project without saving any changes you may have made 
while it was open.

Frames

Save Frames... [Ctrl+F]

This command opens the Save Window with the Selected Frames 
Only radio button pre-selected.

Local Timecodes... [Ctrl+L]

This command allows you to change the timecode individual 
frames within an animation without changing the timecode of 
every frame. Changing the timecode alters how long each frame is 
displayed in an animation before the next frame takes its place. 
Timecodes are set in milliseconds -- a 20 frame animation with a 
global timecode setting of "4" and four local timecodes of "10" 
would take a total of  would take a total of 104 milliseconds to run.

Enter Timecode field

The number entered into this field will define the local time-
code in milliseconds.
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Accept

Clicking this button will apply the local timecode as defined 
in the Enter Timecode field.

Cancel

Clicking this button will close the Local Timecode window 
without applying any changes.

Help

Opens the Help dialog.

Show Frames... [Ctrl+S]

This command loads any frames you have selected sequentially 
into MainView. If you have selected more than one frame to load, 
you may play them sequentially as an animation.

Show Palette... [Ctrl+P]

This command opens the Palette Editor. The Palette Editor is used 
when you are working with 256 (8-bit) images and you want to 
optimize what colors are available. 

You can open saved palettes with the Palette Editor and use them 
instead of the default one.

The Color Grid is a grid of 256 colors (numbered 0-255) are visi-
ble at the top of the window. These are the colors and shades of 
color that the palette is currently using with the animation.

Clicking on one of the squares in the color grid will cause that 
square’s number to appear in the Selected Color field. Any square 
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listed in the Selected Color field is active, and any changes made 
in any of the other fields will affect this block.

It is possible to exchange color information with the selected color 
and another block on the color grid by entering the other block’s 
number in the Swap Color Index field and pressing the "Swap" 
button.

The Red, Green, and Blue fields list the amount of that color (from 
0-255) present in the selected color on the color grid. You can 
change this field by selecting the current value, deleting it, and 
entering another value in its place.

Sort Frames

These tools modify in what order the frames appear in the Frame 
List area. This tool can only be used when you are displaying a 
series of pictures, not animations.

by Name (Normal)

When this option is selected, the frames will be sorted by their 
names. This is a case-insensitive process (whether or not the 
names use capital letters will have no effect on the sort).

by Name (Inverse)

When this option is selected, the frames will be sorted by their 
names inversely. This is a case-insensitive process (whether 
or not the names use capital letters will have no effect on the 
sort).
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by Size

When this option is selected, the frames will be sorted by their 
file size, with the smaller pictures being placed at the top of 
the frame list, and the larger pictures being placed at the bot-
tom of the list.

Remove Frames [Ctrl+R]

This command removes a frame from the Frame List.

Settings

Show Timecodes As

MainActor VE recognizes three different time systems that you can use 
when working on your project.

/1000 Sec

This time code setting displays the timecode for every frame in 
terms of milliseconds.

HH:MM:SS:MS

This time code setting displays the timecode  of the frames relative 
tot he beginning of the project in hours, minutes, seconds and mil-
liseconds. The head of the timecode column will display the time 
of the entire project.

HH:MM:SS.FF

This time code setting is based on a frames per second basis.
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MainActor will determine the frames per second rate of the 
entire project, then display the timecodes based on this fps 
rate in hours minutes, seconds, and frame offset. The frame 
offset is between 0 (the first frame that will appear in the sec-
ond) and the frames per second minus 1 (the last frame 
appearing in that second.

For example, if you are displaying an animation at 5 frames 
per second, the first 5 frames would display the following 
timecodes:

00:00:01.0 (the first frame appearing in the first second)

00:00:01.1

00:00:01.2

00:00:01.3

00:00:01.4 (the last frame appearing in the first second)

The head of the timecode column will display the length of 
the entire project.

Playback

These tools allow you to change the global playback settings of the dis-
play window (MainView).

Autostart

If this item is enabled, the project will play immediately after 
being loaded. Other wise it will wait for a play command from the 
toolbar or the menu.
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Titlebar

Specifies what will be displayed in the Titlebar when the project is 
loaded.

Project Title

The projects title will be displayed in the Titlebar.

Frame Counter

When playing, the Titlebar will display the current frame 
number being shown (when loaded, the Titlebar will display a 
"1" unless only some of the frames in a project were loaded 
into MainView).

Frames per Second

The Titlebar will display how many frames are viewed per 
second.

Repeats

Specifies how many times projects without sound will be repeated 
when they are played. Projects with sound will only be repeated 
once.

Repeats:1

This is the default setting, and selecting this command will 
reset Repeats to 1.
nActor 163



MainActor VE Command Reference

164
Change

Opens the Number of Repeats dialog box which allows 
you to determine how many times the animation will 
repeat itself. You can specify a number between 1 and 
10,000.

Volume

Specifies the volume of the sound contained within your ani-
mation.

Volume:80

This is the default setting, and selecting this command 
will reset the volume of your project to 80.

Change

Opens the Sound Volume dialog box. Specify a number 
between 1 and 100.

Full Screen

This command is only available to systems that support 
DirectX. It enables the project to run in full-screen mode.

Scale to Screen

This command is only available to systems that support 
DirectX, and will only work when Full Screen mode has been 
selected. It will scale the image to fit the entire size of your 
screen.
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Use Best Mode

This item is only available to systems that support DirectX, 
and will only work when Full Screen mode has been selected. 
If this command is chosen, MainActor tries to find the best 
possible screen mode for the project which is available on 
your system. Otherwise, full screen playback will always use 
the screen mode of the OS user interface. 

Toolbar

These commands allow you to control the behavior of the toolbar.

Active

When this command is activated, the toolbar appears underneath 
the MainActor VE menu. When this command is de-activated, the 
toolbar is removed. The default setting for this command is "on."

Context Help

When this command is activated, you will get help messages 
which describe the functions of the toolbar when your mouse rests 
over each button. When this command is de-activated, this con-
text-sensitive help does not appear. The default setting for this 
command is "on."

Language

Sets the default language of the program. Note that MainActor VE 
must be restarted for changes to take effect.

English

This command sets the default language of the program to 
English.
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German

This command sets the default language of the program to Ger-
man.

Mini Icons

This command toggles the size of the frame icons in the Frame View 
area from large to small.

Font

This command allows you to define the system dialog font throughout 
the application.

Help

Context Sensitive Help

Selecting this menu item turns the cursor into a question mark shape. 
When you click the cursor on a part of the window, help for that area 
will be displayed.

About Context Sensitive Help

Displays information on using context sensitive help.

MainActor Documentation

Displays the MainActor online documentation.

MainActor Rexx Reference

Displays the online reference for the MainActor-specific Rexx com-
mands.
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Rexx Introduction

This command will open the Rexx Introduction and tutorial help 
screen.

Rexx Reference

This command will open the Rexx Reference help screen.

Loader Modules

This command allows you to view all of the file formats and codecs 
that MainActor can load and play.

Saver Modules

This command allows you to view all of the file formats and codecs 
that MainActor can save projects as.

Product Info

This command opens the product information dialog box.

The Save Window

This section describes the Save window in detail. The Save window is 
used to create the animation, bitmap, and sound files of your project.

Module 

This list allows you to determine the file format of the project (or indi-
vidual frames from that project you are extracting).

When selecting a file format, be careful to choose a format that is 
appropriate for what you are actually doing. If you are extracting files 
from a video clip, don’t save them as AVIs or in Quicktime MOV for-
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mat -- save them as GIFs, JPEGs, or TGA. If you are extracting five 
frames from a 40 frame animation and choose AVI as your file format, 
those five frames will be linked to create a 5-frame AVI. If you’re just 
trying to extract part of a movie as a smaller movie this is fine, but if 
you’re trying to extract the frames to alter them or display them as 
graphics, you need to save them in a graphic format. Likewise, if the 
project is a 40 frame animation, if you select the JPEG format then 
MainActor VE will save your product as 40 separate JPEG files.

This may seem self explanatory, but all of the file formats are thrown 
together in the same list, and it’s possible to accidentally select a format 
that is unsuitable for your purposes.

Type

Type tells you whether the Module you have selected is a picture (still) 
or animation (moving picture) format. Use modules classified as "pic-
ture" if you are trying to extract frames from movies to use as graphics; 
use modules classified as "animation" if you are converting a series of 
frames into an animation or a movie, or are converting an animation 
from one format to another.

Codec

The Codec listbox allows you to specify certain characteristics of the 
Module you have selected. For example, if you have chosen the Mod-
ule "AVI", the Codec listbox allows you to specify the AVI as one of 
the following:

• 256 Colors: Microsoft RLE

• 256 Colors: Uncompressed

• Millions of Colors: Intel Indeo(TM) R3.1

• Millions of Colors: Motion JPEG

• Millions of Colors: Ultimotion(TM) IBM
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• Millions of Colors: Uncompressed

Each of these choices will affect the size and image quality of the file.

Width

 It is possible to change the default width (in pixels) of the picture or 
animation by highlighting the number already in this field, deleting it, 
and typing in a new one. Smaller sizes generally produce smaller files, 
larger sizes generally produce larger files.

Height

 It is possible to change the default height (in pixels) of the picture or 
animation by highlighting the number already in the field, deleting it, 
and typing in a new one. Smaller sizes generally produce smaller files, 
larger sizes generally produce larger files.

Time

When you save an animation, the Time counter will count up the total 
length of the animation as the save process progresses.

Index

If you are extracting multiple frames from an animation and saving 
them as a picture, they will be saved under the same name with a four-
digit number tagged onto the end of it, allowing you to a) identify them 
as coming from the same project, and b) identify the order in which 
they appeared in that project. The number in the Index field is the 
"starting" point of this numbering system, so if the Index is set to "1" 
and you save four frames under the name of "frame", they will be 
named frame0001, frame0002, frame0003, and frame0004. Likewise, 
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if the Index was set to "10" they would be named frame0010, 
frame0011, frame0012, and frame0013.

Progress

 Keeps track of the saving process. When you actually begin to save 
your project (create your move, or extract your frames) the progress 
indicator will show you how close the job is to being finished.

All Frames/Selected Frames toggle

The radio buttons for "All Frames" and "Selected Frames" allows you 
to specify whether or not you want the settings on this dialog box to 
affect the entire project, or only the frame or frames you have selected. 
If you select four frames in a 40 frame animation and want to extract 
them, choosing the "Selected Frames" radio button will allow you to 
do this. Choosing the "All Frames" radio button, however, will extract 
all 40 of the frames from the project.

Status

 Usually "Idle" or "Saving", Status tells you what the program is cur-
rently doing.

Save...

When you have finished configuring the Save Window to your satis-
faction, the Save... button will call up a file dialog box, allowing you to 
name and save your project.
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The Save Window
Cancel

Cancel will close the Save Window without saving or modifying your 
project in any way.

Palette...

Animations and pictures that will be shown in only 256 colors often 
benefit from being optimized as an 8 bit image. The Palette... button 
will open the Palette Editor, which allows you to do this.

Options...

The Options... button opens the Save Options window, which allows 
you to define more specific properties of the project you are saving. 
The properties that can be set are

Interpolate pixels while scaling (default)

If you have altered the Height and Width fields in the Save Window, 
this setting will interpolate the projects pixels when scaling it to the 
new size, resulting in less blocky looking images.

Use error diffusion when reducing colors

When saving 8 bit (256 color or grayscale) animations and pictures, 
this option enables an error diffusion algorithm to dither the image 
data. This option is useful when saving deep, 24 bit projects to 8 bit 
projects, as it reduces the visible "artifacts" (rough areas that appear 
when colors don’t blend smoothly) of the color reduction.
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Module Options

The Module Options button opens the Module GUI Interface, if appli-
cable. This allows you to set options specific to a particular saver mod-
ule.
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APPENDIX C MainActor Sequencer
Command Reference
This appendix describes the menu commands of MainActor Sequencer.

Menu Commands

File

New

Creates a new video sequencer project file.

Open... [Ctrl+O]

 Opens an existing video sequencer project file.
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Save [Ctrl+S]

Saves the current video sequencer project file. If the current 
project is unnamed, a file dialog will appear and allow you to 
specify a path name for the file.

Save as.. [Ctrl+A]

 Opens a file dialog that allows you specify the path and filename 
to save a video sequencer project.

Export... 

Allows you to export your video sequencer project to any sup-
ported file type such as MPEG.

 Exit [Ctrl+Q]

 Closes MainActor Sequencer. If you have any unsaved changes, 
you will be prompted to save or discard them.

Edit

Undo: [Ctrl+Z]

Undoes the last action. Each successive click undoes the next most 
recent action. The number of undo levels is set in the Preferences 
dialog.

Redo: [Ctrl+Y]

 Re-applies the action that was undone. Successive clicks redo 
successive undo actions.
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Menu Commands
Clear Undo History

 Clears the buffer containing all of the actions that can be undone. 
After selecting this, you will not be able to undo any actions done 
previously.

Cut [Ctrl+X]

Removes the selected item and places it in the clipboard.

Copy [Ctrl+C]

 Copies the selected item(s) to the clipboard.

Paste [Ctrl+V]

Pastes the contents of the clipboard to the current cursor location.

Delete [Del]

Deletes the selected item(s), but does not copy it to the clipboard.

Preferences... 

Opens the Preferences dialog box, which allows you to set various 
program parameters (such as the number of displayed program 
tracks, or the number of undo levels.)

Object

Copy Object to Library [Ctrl+L]

Copies the object currently selected on the timeline to the object 
library for use at a later time.
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Information [Ctrl+I]

Opens the Object Information dialog box, which displays informa-
tion about the object currently selected on the timeline.

Video Path... [Ctrl+P]

Opens the Video Path dialog box, which allows you to change the 
video path used by the object currently selected on the timeline.

Video Effects... [Ctrl+E]

Opens the Video Effects dialog box, allowing you to select various 
video effects (Blue, Brightness/Contrast, etc.) to be applied to an 
object selected on the timeline.

Video Settings... [Ctrl+N]

Opens the Video Settings dialog box, allowing you to change set-
tings for things like video position and the alpha channel for an 
object.

Audio Effects... [Ctrl+D]

Opens the Audio Effects dialog box, allowing you to select vari-
ous audioo effects (band pass filter, echo, reverb, etc.) to be 
applied to an audio object selected on the timeline.

Settings... [Ctrl+T]

Opens the Object Settings dialog box, allowing you to set various 
parameters for the object currently selected in the timeline.
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Overlay Settings... [Ctrl+R]

Opens the Overlay Settings dialog box, allowing you to define 
which portion of the overlay object (an object in the V1 - V96 
tracks) is transparent.

Reset Volume Controls [Ctrl+U]

Causes the volume control settings to revert to the default values.

Split Object... [Ctrl+J]

Splits the audio and video information of an animation into sepa-
rate objects. This is useful if you need to adjust the video/audio 
sync.

View

Browser Window

Toggles the display of the Browser window.

Preview Window

 Toggles the display of the Preview Window.

Timeline Player Window

Toggles the display of the Timeline Player Window which allows 
you to control the preview playback of the current video.
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Help

Context Sensitive Help

Selecting this menu item turns the cursor into a question mark 
shape. When you click the cursor on a part of the window, help for 
that area will be displayed.

About Context Sensitive Help

Displays information on using context sensitive help.

Sequencer Documentation

Opens the MainActor Sequencer online documentation file.

Product Info… 

Opens the product information 
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